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Phew! January was a whirlwind of activity.
Without much hesitation – if any at all – users, ISPs,
webmasters, Internet search engines, and just about
anybody else with an interest in maintaining a free
and open Internet, rallied around the opposition to
the SOPA and PIPA bills that were up for
consideration in the U.S. House of Representatives
and the U.S. Senate, respectively.
The fervor expressed against these two bills has, at
least for now, made any support of such legislation a
toxic topic among U.S. lawmakers – especially since
2012 is an election year. No U.S. lawmaker will even
step near the topic. That’s how toxic it has become.
Still, the MPAA, the RIAA and their
puppet groups continue to look for a
legislative solution to their perceived
ills and trespasses, completely
disregarding even the search for a
technological solution or – heaven
forbid – a fundamental change in
their outdated business model.
SOPA and PIPA were defeated, this
time around. Those who fought to
keep the Internet open and free can
breathe a collective sigh of relief –
but then need to get right back on
guard duty, since the threats to a
free Internet seem to be coming as
fast a bullets fired from a U.S. Civil
War era Gatling gun.
Just one day after the successful
“Internet Blackout Day” on January
18, 2012, where many sites went

“dark” in protest of SOPA and PIPA and Internet
users flooded the U.S. Congressional email boxes
with millions upon millions of letters and petitions
opposing the two bills, the U.S. Department of
Justice, coordinating with the governments and law
enforcement agencies of other countries, took down
the MegaUploads file sharing site. They cited that
the operators of MegaUploads were guilty of
copyright infringement on a massive scale. Naturally,
this raises a very good and necessary question: “if
they can do this, why do they need SOPA?”
Already, Spain has succumbed to to pressure from
the U.S. to pass SOPAlike legislation, to help
protect copyrighted works there. More recently, Irish

lawmakers have sought to
pass another SOPAlike act.
All around the world, a free
and open Internet is coming
under attack. Without
hesitation or doubt, those
threats can be traced back to
the MPAA and RIAA.
Both groups have a history of
“crying wolf” whenever new
technology is introduced or
becomes popular. They claim
that [insert new technology
here] will destroy their
markets. Yet, time after time,
both groups have only seen
their profits soar – which is
exactly the same thing that is
happening today. It’s not that
they are afraid of their
markets being destroyed.

Rather, it’s just pure, unadulterated GREED that
motivates these mongrels. They want to be able to
extract every fraction of a cent out of those who do
pay for the content they produce. Meanwhile, none
of the laws that have been proposed will do much of
anything to curb piracy, since it doesn’t address bit
torrent file sharing, perhaps the most widespread
way of distributing pirated content.
Of course, there is no regard whatsoever given to
the millions and billions of legitimate files that are
shared between users, both via http and bit torrent
avenues. It’s a bit like saying, “well, this guy got
killed by being hit in the head with a hammer, so
let’s ban all hammers,” without regard to the fact that
hammers also have a legitimate, nonlethal use.
A new threat to a free and open Internet is on the
horizon, and it is called ACTA (don’t you just love all
these acronyms?). It stands for Anti Counterfeiting
Trade Agreement, and you can get the full lowdown
by visiting the previous link to Wikipedia. Boy, is this
one a winner – not! Basically, ACTA sets up a rogue
international agency to “combat” counterfeiting and
copyright infringement. As if none of the laws and
measures already on the books don’t already
address such deeds.
Until next month, I wish each of you peace, solitude,
serenity and good health.
Remain vigilant against encroachment upon our free
and open Internet. It IS under attack, and like never
before!

Welcome From The Chief EditorWelcome From The Chief Editor

http://en.wikipedia.org/wiki/Anti-Counterfeiting_Trade_Agreement
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by Darrel Johnston (djohnston)

There are a dozen or more Gnome panel
applet packages available in the
PCLinuxOS repositories. We will look at
six of them. Zen Mini comes with a single
Gnome panel at the bottom of the
desktop. I created a second panel and
placed it at the top of the desktop so that I
could keep track of the extra applets
installed, and so that the bottom panel
would not become cluttered. Above is a
screenshot of the top panel. From left to
right, the applets are, by package name,
gnometimerapplet, gnomeappletmusic,
filebrowserapplet, istream and gnome
appletnetspeed. “Wait a minute,” you
may say. “That’s only five.” I’ll cover the
sixth one at the end of the article.
gnometimerapplet
Hover your mouse over the timer applet and you will
see a help balloon stating “Click to start a new timer
countdown.”

Left click the applet and a dialog window will appear.
The countdown timer has fields for hours, minutes
and seconds. Fill in the time desired, then click the
Start Timer button. Click the Manage Presets button
to create and store preconfigured countdown
timers. I created one with a time limit of ten minutes
and named the preset “10” (above).

Right click the timer applet and
select Preferences to set them
(below).

gnomeappletmusic
Hover your mouse over the music applet and you
will see a help balloon stating “Launch Rhythmbox.”
Rhythmbox is the preconfigured default music
player for this applet. The screenshot at right shows
VLC because I changed the
preferred plugin.

Rightclick the music applet and select Preferences
to see the window shown above right. Note that
some of those preferences will depend on the music
player’s ability to show the information requested.

Right click the
music applet
and select
Plugins to see
the window
below, and to
select your
preferred music
player. The plugins with the white bar inside a red
circle next to them have the “No module named …”
message showing.

filebrowserapplet
Hover your mouse over the file browser applet to
see the help balloon “Browse and open files in your

Gnome 2.32: Gnome Panel AppletsGnome 2.32: Gnome Panel Applets
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home directory”. I could find no option to change the
contents of the help balloon.

Right click the file browser applet and select
Preferences to see the window below. You can add
file browser paths with corresponding labels.
However, each new label will show the same “open
files in your home directory” balloon. There are
several folder view options. Although the Select
applet icon button allows you to browse for an
alternate icon image to be used, the icon does not
show anywhere in the panel or in the file browser
windows. The label name is what appears in the

applet. You
can also select
an alternate
terminal and
text editor.
Shown at
center top is
the file browser
menu that
appears when
you left click on
the file browser
applet. Simply
navigate the
menu to the
folder or file
you want
opened.

istream
Hover your mouse over the istream applet to see a
summary of the song title playing. The applet is an
Internet radio station player similar to Radiotray.
None of the stations selected would show any of the
meta information associated with Album, Genre,
Comment or Location.

Left click the red icon in the istream applet to see the
radio station labels. There is no GUI configuration
for the applet. The station list configuration is stored
in a simple hidden text file in your home directory
named .istream. Shown below is the default
configuration.

#format is:##<Displayed Text> (<invisible Text>)=<url>##url format:##http://<....>#file:///home/user/<file>### my radio stations:#Classic Rock=http://205.188.215.226:8018Country=http://216.218.159.151:8020Motown=http://208.53.158.48:9170Rock=http://64.71.145.130:8070Modern=http://207.200.96.230:8002Urban=http://64.71.145.130:8055Blues=http://64.62.252.130:8030New Age=http://64.202.98.133:9130Jazz=http://207.200.96.226:8052Club mix=http://38.118.158.78:8070Metal=http://205.188.215.225:8022
I changed the Classic Rock station to another URI
and commented the Club mix line. Neither of those
two stations would load for me. It should be noted
here that if a station will not load, the istream applet
will hang and refuse to respond to any mouse clicks.
It doesn’t seem to affect any other desktop
operations. The only method I found of regaining
control of the applet was to log out and log in again.

Gnome 2.32: Gnome Panel Applets
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The istream applet does not automatically start
when you log in. In trying to track down radio station
URIs, I came across an excellent radio tray station
list compiled by “wolfgar”. Although the radio tray
format is a little different than istream’s, the
important thing is having a large list of internet radio
station URIs, along with the corresponding port
numbers, that can be easily copied from. Doing an
Internet search for streaming radio stations can be a
frustrating experience, as many of the compiled
“lists” are actually just links to the stations
themselves. Many of those stations require you to
listen online using a flash player, or, worse yet, a
Windows Media Player.

gnomeappletnetspeed
Hover your mouse over the
netspeed applet to see a short
summary of the monitored
network device.
Right click the netspeed applet to see a more
detailed summary of the monitored device.

Right click the netspeed applet and select
Preferences to see the window at above right. If you
have more than one network device, you can select
which one is to be monitored.

gnomewindowpickerapplet
Last, but not least, is the window picker applet. This
is the one applet that did not appear in the first
screenshot of the Gnome panel. Until you open a

window, you may not even be aware the applet is
actually installed. All open windows, even when
minimized, are shown in the applet, represented by
the application’s icon. Below, you see the home
folder, PCLinuxOS Control Center and firefox icons.
Hover your mouse over one of the icons to see its
window title.

The Gnome panel at the bottom of Zen Mini’s
desktop has a Window Selector applet at the far
right side of the panel. However, using the window
selector applet, you can only select a minimized

Gnome 2.32: Gnome Panel Applets
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window to be restored to the desktop. Right clicking
on any icon in the window picker applet gives you a
few choices to manipulate the application’s window,
all from the window picker applet.
These are but a few of the Gnome panel applets
available from the PCLinuxOS repositories. How
many of them will you find a use for?

Gnome 2.32: Gnome Panel Applets

Screenshot ShowcaseScreenshot Showcase

Posted by Melodie, January 16, 2012, running Openbox.

Want to keep up on the latest that's
going on with PCLinuxOS?

Follow PCLinuxOS on Twitter!
http://twitter.com/iluvpclinuxos

http://twitter.com/iluvpclinuxos
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You're just too marvelous
Too marvelous for words
Like glorious glamourous
And that old standby amorous
It's all too wonderful
I'll never find the words
That say enough tell enough
I mean they just aren't swell enough
You're much too much and just too very very
To ever be in Webster's dictionary
And so I'm borrowing a love song from the birds
To tell you that you're marvelous
Too marvelous for words

ms_meme's Nook: Too Marvelousms_meme's Nook: Too Marvelous

MP3 OGG

http://pclosmag.com/html/Issues/201202/files/TooMarvelous.mp3
http://pclosmag.com/html/Issues/201202/files/TooMarvelous.ogg
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by memcpy

Before I begin I’d like to discuss my qualifications. I
am a student majoring in Computer Science, and I
have completed (and am certified for) the following
courses by Standford University:
Human Computer Interaction
Computer Science 101
Machine Learning
Cryptography
Computer Security
Design and Analysis of Algorithms I
Networking I
Networking II
Now that we’ve got that out of the way, lets begin:
SOPA is disguised as an antipiracy bill. Any first
year CS student knows better. The bill is, in
actuality, designed to obliterate free speech on the
internet and allow media publishing companies to
commercialize everything.
SOPA explicitly states that companies will be liable
for everything their users post. Sites like Facebook,
YouTube, Twitter, Reddit, Wikipedia, or any sites
that allow user generated content CANNOT exist
under these laws. Immediately after this bill is
passed, you will see the media mafia (MPIAA, RIAA,
etc) replacing websites like Wikipedia with
commercialized encyclopedia software. Mainstream
media outlets will not cover this bill because they are
the ones lobbying for it.

“I don’t really know much about the internet, but we
should pass this bill” – Congressman Walt
If you’re not fond of the internet you may even think
it will increase jobs or help the economy like they
claim. It will do none of these things. The media
industry has been the least impacted by the
recession in terms of jobs, and it contributes hardly
anything to our economy.
(Understanding Media in Economic Development
http://www.peterleeson.com/KyklosMedia.pdf)
You may say “well, it will stop piracy at least, won’t
it?” The issue is it can’t, and they know it can’t.
“Instead of closing down and arresting everyone in a
crack house, it's like changing all the street signs and
roads so that it's a lot more difficult to find the crack
house. But it's still there, and if you try hard enough, you
can find it. It also messes everyone else up, making places
much hard to find for everyone else.”

–– U.S. Representative Jared Polis
Domain Name Servers are a lot like street signs.
Each individual Domain Name record is assigned to
the IP address of a website, and perhaps a markup
address. It’s very simple.
google.com forwards to––> 74.125.159.99
Browsers, by default, interact with any IP or domain
name they are given on port 80, via the Hyper Text
Transfer Protocol. It makes no difference whether
you type the domain or the IP. This bill targets DNS
only, ending nothing but your ability to type
“google.com” instead of “74.125.159.99.”

There’s more than one protocol on the internet.
There are thousands of well established protocols.
This bill only targets HTTP, while more than 95% of
all piracy occurs over the BitTorrent protocol, which
utilizes neither HTTP or DNS. This bill does nothing
to stop piracy and has a catastrophic impact on the
structure of the internet which currently allows the
free exchange of information.
You probably think this is ridiculous, and that there’s
no way it could pass. If only I was that naive. Lets
take a look at a U.S. Supreme Court Case (City of
Ontario v. Quon) in which Chief Justice John G.
Roberts, Jr. was lacking a bit of knowledge:
“What is the difference between an email and a pager?” 
Chief Justice John G. Roberts, Jr.
Kennedy asked what would happen if a text
message was sent to an officer at the same time he
was sending one to someone else:
“Does it say: ‘Your call is important to us, and we will
get back to you?’” Kennedy asked.
These are the people making important decisions
about the fate of the internet.
Politicians have been brainwashed to believe that
copyright infringement is the same as physical theft.
Congressman Walt likened it to walking into a store,
stealing a video game, and ignorantly remarking that
someone could be harmed in the process. You may
think so too if you don’t fully understand copyright
infringement, which is nothing to be embarrassed
about. It’s a complicated subject, however, the U.S.

SOPA For DummiesSOPA For Dummies

http://www.techdirt.com/articles/20120108/00533117331/study-confirms-news-networks-owned-sopa-supporters-are-ignoring-sopapipa.shtml
http://www.techdirt.com/articles/20120108/00533117331/study-confirms-news-networks-owned-sopa-supporters-are-ignoring-sopapipa.shtml
http://www.peterleeson.com/Kyklos--Media.pdf
http://lawyersusaonline.com/dcdicta/2010/04/19/technical-difficulties-at-the-supreme-court-2/
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supreme court has recognized the distinction
between copyright infringement and theft, noting that
“nothing was stolen because the original was never
removed or modified.” (reference: Dowling v.
United_States (1985))
The only way you are going to change their minds is
if their constituents outweigh the hundreds of
thousands of dollars they have received in lobbying.
It currently racks in (12/25/2011) at over 100 million
dollars. They were advised to take the advice of
experts and one of them (the name plates weren’t
visible) snidely remarked “I don’t need an expert’s
opinion to know this bill is good.”
CBS VIACOM, Microsoft, and Disney all distribute
uTorrent, Kazaa, Limewire, Frostwire, and other
popular copyright infringement software on their
websites, then turn around and sue people for it.
CNET even has a search engine specifically
designed to find MP3s (and offers embedded
download links)  CNET is owned by CBS VIACOM.
This bill isn’t designed to eliminate piracy, it is
designed to give them control of the internet, the
pesky free speech tool that has crippled their
obsolete business model.
I won’t give you a sales pitch for my social
networking mediums, but I’ll provide them in case
you want to ask me questions:
Twitter
Website
In a nutshell...

Eitor’s Note: This “explanation” of SOPA and PIPA has
been floating around the Internet throughout the month of
January, with many blogs printing it in its entirity. We
reprint it here in the hopes of PCLinuxOS users gaining a
better insight into what these bills, as well as bills like
them, mean for the average Internet user – especially for
those in the U.S.

SOPA For Dummies

International CommunityPCLinuxOS Sites

Netherlands

Turkey

Denmark
Czechoslovakia

Italy

Poland

Visit Us On IRCVisit Us On IRC
• Launch your favorite IRC Chat Client software
(xchat, pidgin, kopete, etc.)

• Go to freenode.net

• Type "/join #pclinuxosmag"
(without the quotes)

http://en.wikipedia.org/wiki/Dowling_v._United_States_(1985)
http://en.wikipedia.org/wiki/Dowling_v._United_States_(1985)
http://www.youtube.com/watch?v=WJIuYgIvKsc
http://www.youtube.com/watch?v=WJIuYgIvKsc
http://www.youtube.com/watch?v=WJIuYgIvKsc
http://www.twitter.com/snapdata
http://memcpy.ws
http://www.pclinuxos.nl/
http://www.bekozap.com/
http://www.pclinuxos.dk/news.php
http://www.pclinuxos.cz/
http://pclinuxos.it/
http://pclinuxos.org.pl/
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by Paul Arnote (parnote)

January 18, 2012. The day the Internet went dark.
No more Wikipedia. No more Google logo on the
Google home page. Wordpress … censored. Lights
out on Mozilla. The Electronics Frontier Foundation,
fighting for our digital freedom. Wired … unwired
and censored. XBMC gone dark. Symbolically, at
least for one day.
Even the web site of our own Patrick Horneker
redirected to an “Internet Goes On Strike” page to
show opposition to the proposed SOPA and PIPA
bills now up for consideration before the U.S.
Congress.
Most conspicuously absent from participation among
those websites and content providers opposing
SOPA and PIPA were Facebook and Twitter. The
CEO of Twitter publicly announced his opposition to
participating in the blackout, citing that it did not
make good sense on a global business scale to
black out the Twitter site. (I wonder who would cry
foul loudest if Twitter became a victim of the type of
Internet censorship that SOPA and PIPA would
impose). My wife was able to effortlessly log into her
Facebook account, without any mention of the
blackout or either bill.
Just in case you’ve just awoken from a LONG
hibernation, here’s a brief – and informal –
explanation of what’s going on. (If you want a more
concise and better explanation, watch this video.)

Some of the more notable participants in the fight opposing SOPA and PIPA during the Internet blackout campaign
(from top to bottom, left to right): Electronic Frontier Foundation, WordPress, Google, Wikipedia, XBMC, Wired and
Mozilla.

January 18, 2012January 18, 2012The Day The Internet Went DarkThe Day The Internet Went Dark

http://horneker.com
http://vimeo.com/31100268
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Since before Christmas 2011, the proposed SOPA
and PIPA bills have caused a feverpitched fervor
and outrage among those who have embraced the
Internet and the digital realm. The bills were put forth
by special interest groups – the same people who
distributed LimeWire, cNet downloads, iMesh,
Napster and other file sharing applications – to
prevent the piracy of their intellectual property.
These same companies, largely backed by the
MPAA and RIAA, are the record companies and
movie studios, among other digital content creators.
So, a few members of the U.S. Congress and
Senate took up their pleas, drafting horrible
legislation (probably the worse legislation ever
drafted in the history of the U.S. legislature) to

protect those intellectual property rights – by
penalizing web content providers, and shutting down
web sites who are even suspected of copyright
infringement, all without the due process of law that
is protected by the U.S. Constitution. Then they
attempted to ramrod the bills through their
respective bodies of the legislature before the
annual winter holiday break.
Not so fast!
Once tech companies, Internet service providers,
web content providers, web search engines, and
virtually anyone else who participates in the free
exchange of ideas and knowledge over the web got
wind of these bills, the fight was on like Donkey
Kong. Largely ignored by the mainstream media
(after all, virtually every one of their parent
companies support SOPA and PIPA), there has
been exceptionally little in the daily U.S. news about
these bills. That is, until January 18, 2012.
With literally thousands of websites participating in
the blackout, either by completely blacking out their
website for the day as Wikipedia did, or by
obliterating key parts of their website as Google,
Wordpress and Wired did, the mainstream media
had no option but to cover the story.
Repeatedly, in virtually every story that appeared on
the mainstream medias’ websites, you saw the
disclaimer that their parent companies were ardent
supporters of SOPA and PIPA. Even though you
had to search the web page to find the coverage of
the unified Internet blackout move (it was usually
buried in the “other news of the day” category), there
was indeed coverage. In fact, on the MSNBC news

site, the video about the Internet blackout was, by
the website’s own counter statistics, the most
watched news story of the day. On the CBS News
website, they offered up a public poll simply asking,
“Should SOPA and PIPA be passed?” The results
were no surprise: 97% said no, 1% said yes, and 2%
were undecided.

Throughout the day, many key members of the U.S.
Congress withdrew their support from the two bills,
presumably due to the outcry from their constituents.
I know that I signed every petition I came across
during the day on January 18, 2012 that voiced
opposition to SOPA and PIPA. Attempts to log into
the home pages of my two U.S. Senators on the
U.S. Senate website resulted in errors, as the
Senate web servers were worked beyond capacity
and overloaded. However, I was able to get into the
email comment page of my U.S. Representative
(Missouri 5th District), and I left him the following
email:
PLEASE show your support for an open and free Internet
by voting NO on SOPA and PIPA. The Internet has
historically been about free and open exchange of ideas
and knowledge. Both of these bills, if enacted, would gut

January 18, 2012: The Day The Internet Went Dark
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the Internet of these ideals and principles. In the past, the
U.S. has been harshly critical over other countries who
restrict access by their citizens to a free and open Internet
(most notably The People's Republic of China, and Egypt
during the recent demonstrations for government change
there). Under SOPA and PIPA, the United States will join
them in curtailing free and open access to the Internet to
its citizens.
While I can see some importance in protecting intellectual
property rights, SOPA and PIPA go way too far, with far
too heavy of a hand. The Internet, if it is to survive, must
do so without encumbrances of legislation by ANY
country, and free and unfettered access to the Internet, by
those who wish to access it, should be allowed.
Legislation is NOT the way to protect intellectual
property rights; rather, let the makers of those goods find
other methods (e.g., the marketplace and technology) to
protect IP rights.
Please, do not allow SOPA and PIPA, which cater only to
special interest groups, to pass.
Thank you for your time.

The fight is just beginning. Those who are ever
vigilant about fighting for Internet freedom and
keeping government regulations and legislation from
oppressing a free and open Internet must not let
their guard down. There will be other attempts in the
future by governments world wide to regulate the
Internet. Spain was the latest casualty in this fight,
bowing to pressure from the U.S. to pass antipiracy
legislation with very similar wording to SOPA and
PIPA. The governments of the world seem to not be

able to just stand by idly without their paws and
fingers dipping into an unregulated, free flowing river
of ideas and knowledge that the Internet represents.
Perhaps the temptation to extend their influence of
power is just too great. Perhaps they are fearful of a
well informed constituency. After all, knowledge is
power, and they’ve spent untold fortunes in their
attempts to “dumb down” society. Plus, it is much
easier to rule over an uneducated, ignorant and
dumb populace.
Update: It appears that the protest was successful –
at least for now. U.S. Congressman Lamar Smith
has withdrawn the SOPA bill, and for all intents and
purposes, PIPA is also dead in the U.S. Senate,
dying a deserved death in committee.
Former U.S. Senator and current head of the MPAA
Christopher Dodd expressed surprise at how the

widespread worldwide outcry against these bills
“changed the game.” He, along with his
entertainment industry cronies, thought that they
were going to be able to shove these bills through
Congress and garner an easy victory, without hardly
anyone noticing.
Also playing a hand in the defeat of SOPA and PIPA
was an announcement from the White House on
Saturday, January 14, 2012. “While we believe that
online piracy by foreign websites is a serious
problem that requires a serious legislative
response,” said the note, “we will not support
legislation that reduces freedom of expression,
increases cybersecurity risk, or undermines the
dynamic, innovative global Internet.”
Although a clear message has been sent by Internet
users, ISPs, etc. in regards to this attempt to
regulate and censor the Internet, don’t
underestimate the ability and desire of politicians to
try again in the future. We must remain ever vigilant
to preserve an open Internet, since it is often the
only avenue available to a vast majority of the
people of this world for an open exchange of
knowledge, information and ideas.
They (the content providers, represented largely by
the MPAA and RIAA) have “cried wolf” before,
claiming that technological advances that came
down the pipe were “going to ruin Hollywood” or
“going to ruin the music industry.” They did this with
cassette tapes, home video tape recorders, home
DVD players/recorders, MP3 players … the list goes
on and on. It seems that every time a new
technology gains popularity, they go running off in
fear to legislators, seeking a preemptive legislative

January 18, 2012: The Day The Internet Went Dark

http://www.whitehouse.gov/blog/2012/01/14/obama-administration-responds-we-people-petitions-sopa-and-online-piracy
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cure. Yet, in every one of the previously cited
instances where they feared that their respective
industries were going to be “ruined,” their total sales
and profits only increased. You would think that
we’ve become accustomed to their mentality by now.
Somewhere down the line, in the nottoodistant
future, another politician, bathed in the same
motives as Representative Lamar Smith, will bow to
the content providers’ special interest group and yet
another run in fear from yet another technological
advance, and attempt to reintroduce a legislative
“cure” for their perceived ills. An even scarier
proposition is that some underhanded, lessthan
scrupulous politician will attempt to sneak an
amendment into another, unrelated bill (like an
emergency funding bill or another bill to raise the
country’s debt limit), that will largely go unnoticed –
until it’s too late.

With this being an election year, let’s hope that the
voters can break from their typically myopic
memories and vote the supporters and authors of
these bills out of office.

We, the users of the Internet and the citizens of this
world, must remain on guard. It is up to us to protect
and fight for a free and open Internet.

Screenshot ShowcaseScreenshot Showcase

Posted by MtnMan, January 12, 2012, running e17.

January 18, 2012: The Day The Internet Went Dark
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Answers on Page 32.

Double Take & Mark's Quick Gimp TipDouble Take & Mark's Quick Gimp Tip

Recently, while working on my
comic strip, I needed to convert
several cartoon images from Tiffs to Jpegs.
Now, I could easily open each in The Gimp
and resave them in the new format. But
that would take a little longer than I wanted.
Luckily, I found an image conversion plug
in in the PCLinuxOS repository. It's called
“David's Batch Processor for The GIMP.” It
allows the user to perform operations (re
size, new format, etc.) on a batch of
selected images. Once installed from the

Mark's Quick Gimp Tip
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repository, you can find the plugin under
Filters > Batch Process. When the filter
is opened and running, simply add images
to the interface and, by selecting any of the
appropriate tabs, adjust the output of your
new files. The batch processing filter does
the rest! It's a quick and easy way to re
size or reformat a large number of images.
(Please note: The application’s description
points out that “DBP is intended for RGB,
not indexed images. Trying to process an
indexed image will probably just cause an
error, and DBP will halt.”)

Find at least seven differences between cartoons.©2
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Mark Szorady is a nationally syndicated cartoonist with georgetoon.com. He blogs at georgetoon.com/blog. Email Mark at georgetoon@gmail.com.

David'sBatchProcessorinterface.

http://www.georgetoon.com
mailto:georgetoon@gmail.com
http://www.gimp.org/
http://www.georgetoon.com/blog
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Forum Foibles: The Heart Of PCLinuxOSForum Foibles: The Heart Of PCLinuxOS

This looks very sweet and one can smell the
sweat and heart blood that went into it.
Thanks Dragynn. looks like a winner to me!
longtom
A hearty thanks to Tex for adding the
metadata information in Nautilus. tddyred
Taking notes for joechimp I lost my heart.
ms_meme
A heartfelt thanks goes to SlingShot for all
his time and effort in making the Knowledge
Base just that much better with his ideas and
help. YouCanToo
As always, my heartfelt appreciation to
Texstar and his truly dedicated support mob
for one the finest Linux distributions out
there! AussieBear
Don't worry, heart always belongs to
PCLinuxOS. Nish

Coming from "the enemy M$", I can say with
hand on heart, that PCLinuxOS is the best all
round Linux system I have found, and like
many people I have tried a few. Reb

Whiskey over ice  can cause you heart
problems. Ice is Really, Really BAD FOR
YOU ! ! ! ! Ramchu
You are too generous, Agust. Thanks.
It's amazing how a simple geometric shape
can be changed and result into a
representation of our community feels ... the
heartbeat of PCLinuxOS. Archie
I've come home to PCLinuxOS and I'm
gonna stay for quite a spell . So thanks to
the developers and especially "Tex" for the
Number one Distro in my heart and in many
others. Great work guys. Rob
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Forum Foibles: The Heart Of PCLinuxOS

The art of words ms_meme does know.
Out of her heart the words just flow.
joechimp
Thanks to TEX for all the enjoyment I get
from using this Distro that is your heart and
soul. joechimp
All I can say is a heartfelt kudos to Texstar
for what you've built. Keep up the great
work. cage47
It's my 500th post, and I thought I'd use it for
a very heartfelt "thank you" to Tex, and to
everybody who works so hard to make this
awesome distro possible! So, thank you Tex!
stricktoo
Whatever the name of the distro is, we are all
linked to the one and only heart  the Linux
kernel. The teeming heart of PCLinuxOS, it is
called the most celebrated meeting place in
the world, and in all history. uncleV

I am continually thrilled and honored to be a
part of this wonderful magazine! The
dedication of its staff and contributors really
comes through. The articles are always
helpful, instructive, and done with a heartfelt
love for this Linux distro. Georgetoon
A heartfelt thanks to one and all for what you
do. dangbert
I am sitting in bed looking at this absolute
masterpiece of work called PCLinuxOS and
would like to add my heartfelt gratitude to
Texstar and all our packagers for their
unselfish commits and the countless time
they've poured to making PCLinuxOS
AWESOME on my machine. Archie
Also Neal, you are such a sweetheart.
sandyv
Well, I did say lighthearted! Mike
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Forum Foibles: The Heart Of PCLinuxOS

PCLOS will make your skills stronger
Use it now don't delay
Run walk to help you live longer
Do it everyday

Blue screen blue skies
Will help your spirits to rise
Boot up just open your eyes
Then try a bit of exercise

Friends in the forum will touch you a lifetime
Remembered even when gone
A steady walk up that hill you'll climb
Your heart will go on and on

PCLOS will last you your lifelong
Use it you won't go wrong
Stay strong with Linux you belong
From my heart comes this small small song

MP3 OGG

http://pclosmag.com/html/Issues/201202/files/mypclosheart.mp3
http://pclosmag.com/html/Issues/201202/files/mypclosheart.ogg
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by Archie Arevalo (Archie)

It was the year 1853, or 1302, or even 1260, but
definitely 4186 when he had to leave his
constellation, Scorpius. You may wonder why he
had to leave one of the brightest stars in the our
galaxy. While it may be true that Antares is a slow
variable star, still …
joe, a.k.a. Rich, as his friends call him. was born on
a sunnyside day in a futuristic hut to intelligent alien
beings we might mistakenly recognize as chimps.
This was 159 years ago.
Like what happened to KalEl, who is sometimes
disguised as Sproggy, many of Antares' inhabitants
believe their star was going supernova, thus
prompting his parents to strap him into a tele
transporter and zap! Before he knew it, he was in
North America, the United States. But ‘til this day,
Antares has not yet exploded! Bummer!
Rich kept his identity hidden until a couple of years
ago, when he made up his mind that he was among
those he would want to be with – our family at the
PCLinuxOS Forum.
Now, oneandahalf centuries later, Rich tell us a bit
more about himself. Artist. Bon Vivant. Man about
town who lists chasing women as one of the things
he likes to do most on his free time ... that is, if the
women aren’t chasing after him.
“I love to know something today that I did not know
yesterday.” The one ... the only ... Rich, a.k.a. joechimp

Forum Family & Friends: joechimpForum Family & Friends: joechimp
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"I also love to listen to music. I have varied tastes in
music so it could be anything one day to the next.
Most of my time, though, is on the computer or doing
some type of art. I really don’t have free time it
seems. Well, I do but I use it to do what I do."
Rich said that he studied classical music in his early
years on Earth, AND played clarinet in an orchestra.
And I was thinking who didn't play the clarinet?
"At some point, other things got in the way and I left
that behind. I received a guitar at an early age and
loved that, but an injury to one of my fingers took the
steam out of that for a long time.
"Between then and now, I decided to play the guitar
with chords and notes in a strange manner.
Sometime after that I decided to take up the bass
guitar and thought that might be easier. I discovered
Jaco Pastorius and the world of the bass was
infused into my DNA.
"I loved everything the bass did for a song. I played
in a few bands, and in recent years, mostly sing at
open microphones, or sit in for a song or two with a
friend’s band. I love to sing most of all now. There is
something about the instrument of the voice that is
so unique to each individual.
"Think about it. You own your voice. You can tune it
any way that it pleases you. It is easy to carry
around. Any type of music can be produced by it. A
great instrument."

"As any musician will tell you the first time you are in
front of an audience and they actually applaud what
you have done. What a feeling. Never gets old."
I thought he'd never stop talking about music so when I
sensed that he was about to take a breath, I asked him,
"You joined the forum in 2009, what specifically made
you stay?"
He said that he was like the many others who
searched. And when he found PCLinuxOS, he
decided that it was his distro of choice.
"What I immediately saw was that the PCLOS forum
was what a forum was supposed to be. People
wanting to help in any way they could. No question
was a stupid question.
"Just19 (then johnboy) and our late friend, Joble,
may he rest in peace, were instrumental in helping
me in my Newbie stage. After running PCLinuxOS
on a LiveCD for awhile, I also wanted to try and run
it on a flash disk. They talked me through every little
issue that I encountered. The generosity of their time
was the key in finding my way to PCLinuxOS and my
"permanent residence" in the forum.
"There were others who helped as well but it's the
two of them who kept me going.
"As I learned more about PCLinuxOS, I knew I made
the right choice. I finally was able to just do things.
Everything worked all the time. No more daily
maintenance as I had with Windows. Always
worrying if I do this, will this break. If I do this will I
get a BSOD. If I do this ..."

Rich, I've concluded, IS unstoppable!
"... you get my point. I was able to enjoy the OS and
do actual things instead of fixing things.
Most of all the people here. Real friends. Not just
faceless people but real friends.
I dared.
"I would name them all but it would take the whole
magazine and I already know what Paul is going to
say. I would also be afraid to leave someone out as
well. All of my friends here know who they are.
"I would be remiss in not mentioning Texstar (Mr. Bill
Reynolds) though. What he has done in creating
what I consider a masterpiece of an OS is simply
amazing. The work he does to provide us with what
is the best of the best will someday be recognized
as remarkable. We already do recognize that.
Someday everyone will.
"Yet he is just one of the guys when he is in the
forum. It’s great. Thank you, sir, for changing my
life."
"I would also single out Neal. He was always there
for me anytime something was bothering me, or if I
needed help with PCLinuxOS. He is quite a guy. He
is a great representative of what is good about this
forum. I hope that someday I have the opportunity to
meet him in person. We will drink coffee and eat
bacon.

Forum Family & Friends: joechimp
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At this point, I was already unsure if I'd want to ask Rich
another question. But I pushed it. How do you generally
find the forum?
"The forum is a great place!
"If a day goes by and I can’t be here , I feel I have
lost something. Any questions I might have on
PCLOS or Linux in general are answered for me in
short order. People genuinely want to help. It is
amazing how much this place has become such an
important part of my life. The Sandbox has become
a second home."
I knew it!

"But, I also want to say a few things about another
important thing to me. I also sit on several State
Boards as a volunteer to help people with disabilities
receive vocational rehabilitation, and to find their
way in the workplace. Or for more independent

living. My time spent there is very meaningful to me.
Mostly what we do is find ways for case workers,
who are overloaded, to find better ways to serve the
public. Whether through legislation or improving
forms or just to educate employers and people in
general to the needs of people with different needs
than their own. This is all very rewarding."
Huh? This is definitely something I am interested in
knowing.
"Cities and towns have offices dedicated to helping
these people in need. Case workers usually have a
long list of people that needed to be helped and
served. We try to find ways to streamline the
process and to reach more people. It is a difficult
process to help so many people. The success rate is
high because the workers are so dedicated.
"Some of the services provided are to help with
educating both the employee and the employer on
how best to utilize a person with disabilities in the
workplace. Sometimes it is just finding a way for
people to utilize public transportation and finding
other ways for them to get around. We recently
completed a revision of a Vocational Rehabilitation
Needs Assessment Survey that is required by the
federal government every couple of years. We could
just go through the motions and send out a basic
survey, but we met multiple times to rewrite
questions and really delve into how we could best
get a response from the thousands of people that
would view this document. We had great success
and I can’t tell you how good that makes me feel.

"The case workers are the unsung heroes. We that
sit on boards and committees are just a small cog in
what gets accomplished. They also help people who
have always lived with someone to take care of
them, move out on their own for the first time and
live independently. Can you imagine the satisfaction
of someone being able to live on their own for the
first time in their lives?
"I can tell you that the things a lot of us just do
unconsciously every day are a major hurdle for
many people, on a daily basis. I am very thankful for
so many things. I hope that someday all people will
find the help they need."
I think being part of the process is what makes each one
of us, especially you, Rich… important. What else can
you tell us about yourself?
"I am also a painter. I paint with acrylic paint on
canvas. I also use other mediums, but my favorite is
acrylic. I paint what I see in my mind. So you can
imagine how strange my paintings are. I guess you
might call them abstract expressionism. Doesn't that
sound cool?
"I also take black and white photos with a film
camera."
Indoors or outdoors?
"I like fishing for largemouth and smallmouth bass.
I used to fish a lot but have had fewer opportunities
in recent years. I have had the good fortune of
having been able to fish in almost 40 of the United
States.

Forum Family & Friends: joechimp
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"Lots of these areas where I fished also provided me
with some wonderful opportunities to see wildlife in
ways that I would not have otherwise experienced."

Interesting? What are some outdoor adventures
Richstyle?

"I once had a big squirrel fall out of a tree when I
was fishing in Missouri. It landed on my arm and bit
me on the hand, fell into the water, then swam to
shore. That was interesting.

"In Florida, I fell off the front of a boat once and
landed on top of an alligator. That wasn't as
interesting.
"Probably the most memorable encounter was when
I was fishing for codfish in about 100 feet of water,
about 27 miles out in the ocean. All of a sudden, a
pod of whales were around the boat. They were pilot
whales, and it was quite a sight. They were so close
that we could reach out and actually touch them.
Well, evidently I went a little crazy. Touching the
whales apparently wasn't enough for me as I jumped
into the ocean with the whales and was able to
touch them and have the experience of my lifetime.
"They were playful creatures. My friend said, "you
could have been killed."

I answered, "What a cool way to go."
Indeed, very interesting and unusual experiences.

“Each and every day I am thankful and feel blessed
by God for all the opportunities that have come my
way.”
Amen to that, joechimp… errr, I meant Rich!

Screenshot ShowcaseScreenshot Showcase

Posted by Meemaw, January 18, 2012, running Xfce.
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by Meemaw
While I’m not a big gamer, I do occasionally like a
game or two. In Gnome,
I installed the package Gnome Games. It is a
collection of many popular computer games. The
Gnome Games Wiki says:
GNOME Games is a collection of fifteen small "five
minute" games in a variety of styles and genres for
the GNOME desktop.

The game icons shown above from left to right are
Lights Out, Five or More, Four in a Row, Chess,
Gnometris, Iagno, Klotski, Mahjong, Mines, Nibbles,
Robots, Swell Foop (or Same Gnome), Tali,
Tetravex, and Sudoku. However, besides the games
the wiki shows at the top of the main page, I got
Aisle Riot Solitaire, Blackjack and Freecell Solitaire
but not Lights Out when I installed the PCLinuxOS
package.
I think it is a nice assortment of games! You get a
few arcade and board games, some are puzzle, and
some are card games. In this article I will show a
screenshot of each game in the PCLinuxOS
package, and give a brief description of each.

In the Arcade section are Gnometris, Nibbles and
Robots.
Gnometris is a
version of the
classic game
Tetris, where
different shapes
fall and one must
arrange them so
each whole

horizontal line is complete. As
soon as it is, the line disappears

and all tiles drop to the bottom. As you proceed
through the game the shapes drop faster. If you fill
up the board and a shape can’t drop, the game is
over.
In Nibbles (center, bottom), you control a worm or a
snake. You are moving around the board eating
diamonds (the round yellow circle at the lower right
of the board). You are competing with up to 6
computergenerated worms competing for the same
diamonds. Every time you eat one you get
longer,and walls appear in other levels, so
navigation around the board gets more difficult. If
you run into a wall or another worm, you start over at
the length you were at the beginning of the game.

In Robots, you are in a space with several Robots
trying to kill you. You can use your mouse or
keyboard to move away from them or use a limited
number of ‘teleports’ to get away. Your aim is to get

Gnome 2.32: Gnome GamesGnome 2.32: Gnome Games
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them to collide with each other and explode. If you
can escape and blow them all up, you win.
In the Boards section, you have Chess, Five or
More, FourinaRow, Iagno and Mahjong.

This is classic
Chess (which
I have never
played). You
can configure
it to show a
2D or 3D
view.

In Five or More, your
aim is to clear the
board by lining up five
or more of the same
color marble, while
the board is filling with
marbles. You can
click on one and move
it to where you want it,
if there is open space
on the board. For
example, I can move
the orange marble in
the lower left corner to
the vertical line of
orange marbles to

cause them to disappear, but the pink one next to
the top on the left can’t be moved because there are
marbles surrounding it. The game is over when the
board is full or empty.

FourinaRow is
the same as the
commercial game,
Connect Four. You
play against the
computer, dropping
your pieces from the
grey area at the top,
while the computer
does the same. You
have to make a line
of four pieces in any
direction, while
blocking the
computer from doing

the same thing. As you
can see, I have lost to
the computer as its blue
pieces have already
formed a line of 4
across.
Iagno (right) is the
Gnome version of
Reversi. You play
against the computer.
When you place a piece
on the board, all of the
computer’s pieces in
between two of yours
are captured and
change to match yours.

However, computer can then place another piece
and capture any of yours that are between its two.
The game is over when the board is full. The winner
is the one with the most pieces.

Mahjong is, of course, the classic
matching game. You click on two
matching tiles and they are removed from
the board. The aim is to clear the board in
the least time possible. The catch is that
you can’t remove a tile that is ‘blocked’ 
that is, if there is a tile on each side of it.
A tile has to be ‘open’ on at least one side
to be removed. In the partially finished
game above, the tile at top left has a
match in the right side of the third row

Gnome 2.32: Gnome Games
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from the bottom, but it can’t be used yet because it’s
blocked. The tile with the 4 dots to its right has to be
removed first.
In the Cards section are Aisle Riot Solitaire,
Blackjack, Freecell Solitaire and, for some reason,
Tali.

Aisle Riot Solitaire contains 86 different versions of
Solitaire. When you open it for the first time, the
default starting game is Klondike. You can choose
the game you want to play by clicking on Game >
Select Game. I play Klondike, Freecell, Spider and
Gaps, but there are plenty more from which to
choose!
You are playing Blackjack (center, top) against the
computer. You can choose how much to wager, and
play the hand however you wish, clicking to deal
another card, or using the ‘H’ to Hit and the ‘S’ to

Stand. Your balance is down in the status bar.

If all you ever play is Freecell (center, bottom), then
having that as a standalone game is pretty handy.

While it is in the cards section, Tali is actually a dice
game. It’s the Gnome version of the popular game
Yahtzee. You can play against up to 5 computer
opponents. Each turn is 3 rolls, during which you are
trying to get the highest score for each category.
You keep the dice you want and roll the rest.
The Puzzles section has some of the previously
mentioned games, plus Klotski, Mines, Same
Gnome, Sudoku and Tetravex.
In Klotski (next page, top left), you have to move
the large blue square out of the board through the
opening where the green squares are. To do that,
you must move the small blue squares out of the
way so your path is clear. The green squares don’t
move, and the large blue square is the only square
that’s allowed out of the outer frame. You have

Gnome 2.32: Gnome Games
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solved the board when the large square is placed
over the four small green squares in the lower right
of the window. The window shown is level 1, and
they get much
harder!
In Mines, you are
trying to find and
mark mines that
are hidden on the
board. When you
carefully leftclick
on a square, the
numbers that
appear show you
how many mines
are in the vicinity
so, hopefully, you

can mark what you believe is the location of each
mine (by rightclicking the board in that spot).

Sudoku is the number puzzle where you fill in the
numbers 1 through 9. The catch is that each section
of the grid can ONLY have one of each number,
PLUS each line and column can have only one of
each number. So... if you are filling in the darker
square, that 3 x 3 section already has 3, 4, 7 and 8,
so your possibilities are 1, 2, 5, 6 and 9. However,
the line that square is in has a 9 in it, and the column
it’s in has a 2 and a 5, so your choices are narrowed
down to 1 and 6. Once you decide which one will
work, do the rest of them the same way.
Same Gnome (top right) is a game we see
everywhere. On the Gnome Games site, it is also
called Swell Foop, but I’ve also seen it on Yahoo as
Bricks Breaking or in KDE as Same Game. You click
on a group of 2 or more likecolored balls, and they

disappear. Any balls above them fall down into the
empty spaces. Your aim is to clear the board.

Gnome 2.32: Gnome Games
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Tetravex is a number matching game. Your aim is to
place the tiles into the board on the left in such a
way that when you are finished, the tile edges that
you place side by side have the same numbers. I’ve
placed one in the center. The one I place to its right
will need to have a number 5 on the left side to
match the right side of the tile I’ve already placed.
When all tiles are placed, all numbers must match.
Synaptic also adds another menu item to Games.
The Other section has Tali and Same Gnome in it.
Have fun with Gnome Games!

Gnome 2.32: Gnome Games
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Posted by djohnston, January 24, 2012, running e17.

Are viruses,
adware, malware &
spyware slowing
you down?
Get your PC back
to good health
TODAY!
Get

Does your computer run slow?
Are you tired of all the "Blue Screens
of Death" computer crashes?

Download your copy today! FREE!

http://www.pclinuxos.com/?page_id=10
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by Paul Arnote (parnote)

After many years of using handmedown and
castoff computers that I’ve literally rescued from the
trash/recycle bin, I’m finally building my own custom
desktop computer. There’s something exciting about
building your own, new, cutting edge computer – all
without having to pay the “Microsoft tax.”
This is my first brand new desktop computer in
almost 10 years. My last one was a Sony Vaio with
an Intel P4 HT 3.2 GHz, 512 MB RAM, a DVDROM,
a DVD+/RW, a 500 GB HD, TV Tuner card with
builtin MPEG2 encoder, eight USB 2.0 ports and a
firewire port (huge deal, back then, it was). It came
installed with WinXP Home – and the usual
abundance of crapware and trialware. To top it off,
the Sony Vaio was a factory refurb, purchased from
the UBid auction site. Still, it was a leading edge
computer for its time. By the way, I still have that
computer and it’s still humming along and still in
great shape.
Prior to the Sony Vaio, my previous brand new
desktop computer was a noname box I purchased
on sale at Office Depot. It ran an AMD Athlon XP
1500+ processor, with 256 MB RAM, onboard video
and sound, and came with Win98 installed. I also
still have this computer.
Without a doubt, this new computer I’ve built should
serve me well for several years to come. So walk
with me, if you will, through the build of this new
custom computer.

“The Parts”
Parts List
CPU: AMD 3.3 GHz FX6100 six core processor.
Motherboard: Gigabyte 970AUD3 AM3+ AMD
motherboard with SATA 3.0, USB 3.0, and up to 32
GB DDR3 RAM.
Hard Drives: 32 GB OCZ Onyx Series SATA II 2.5”
SSD as the primary drive (OS installation) and a 2
TB Seagate SATA 2 hard drive, partitioned into 4
logical partitions for data storage. Icy Dock Dual 2.5”
to 3.5” hard drive mounting adapter used for the 32
GB SSD.

Optical Drives: (2) LiteOn SATA 2 DVD+/RW. (I
decided to skip a BluRay drive at this time, due to
the limited support under Linux).
RAM: 8 GB (4 GB x 2) Patriot PC312800 DDR3
RAM, 1600 MHz.
Video Card: PCIe 16x nVidia 8400 GS with 1 GB
DDR3 RAM.
MultiCard Reader: Rosewill USB 2.0 AllInOne
Card Reader.
TV Tuner Card: Hauppage 1250 HDTV TV Tuner
Card.
Thermal Paste: Ceramique 2 TriLinear Ceramic
Thermal Compound.
Mouse: Pixxo Wireless USB Mouse, model MA
C1G5.
Keyboard: LiteOn 104 Key USB Keyboard.
Computer Case: Rosewill TU155II midsize
AT/ATX case with (4) 5 ¼” drive bays, (5) 3 ½” drive
bays, and 500 Watt power supply.

Assembly
I know that for a lot of computer users, sitting there
looking at a pile of computer parts – in their boxes or
not – can elicit tons of apprehension and push them
towards, er, panic. But I’ve always been one of

My New Desktop BuildMy New Desktop Build



29

those people who love taking things apart and
putting them back together again. In fact, one of my
other interests, (albeit one that I can’t seem to find
much time to indulge in), is woodworking. I love
looking at a pile of raw lumber and envisioning what
I can make from it. Well, I approached this computer
build with that same type of vision.
For those braveatheart souls who wish to
undertake a similar build on their own, I strongly
suggest keeping the individual components boxed
until you are ready to install them, to help keep them
from being damaged before you get around to
installing them. Oh, and please don’t look at this as
a formal howto on building your own computer. I’m
just going to walk you through the general process,
and hopefully give you some “food for thought” along
the way.
The first piece of wisdom I want to impart to you, if
you choose to tackle this (or any time you tinker
around inside your computer’s guts), is to be ever
vigilant to keep static electricity drained from your
body. In the northern hemisphere, it’s winter, which
means that static charges build up easily in the cool,
dry air. Scoot your feet across a carpeted floor and
touch a metal door knob, and you’ll experience that
static electricity first hand. So your vigilance in
keeping that static electricity discharged is even that
much more important than ever.
The best way to do this is to wear an electrostatic
discharge strap, attached to your wrist at one end
and to a good ground at the other. If you don’t have
an electrostatic discharge strap, then position
yourself near a ground and be sure to touch it with
your hand often, and without any components in

either hand. Perform this act faithfully before you
pick up the next component, and you will go a long
way to insuring that your build is successful and that
you don’t ruin any brand new parts before you even
get the chance to enjoy them.

First, we need to install the new motherboard into
the case. Be sure you install the posts in the case to
support the motherboard and to keep the back side
of the motherboard from coming into contact with the
metal case, causing a short circuit – and probable
early death of your new motherboard. Line up the
screw holes on the motherboard with the installation
posts and carefully tighten each of the screws. The
screws should be snug. Take care not to over
tighten the screws, or you could damage your new
motherboard.

Next, install the CPU and the CPU cooler. After
installing the CPU in the zeroforce CPU socket, put
a thin coat of thermal paste on top of the CPU. This
helps improve the contact between the CPU and the
CPU cooler, facilitating heat dissipation. Place and
lock the CPU cooler on top of the CPU, and connect
the fan wires to the appropriate connector on your
motherboard.
Now, you need to install your RAM in the RAM
sockets. My motherboard has four RAM sockets,
supporting up to 32 GB RAM. I chose to go with two
4 GB RAM modules, for a total of 8 GB RAM. This
leaves two empty RAM slots for future memory
expansion, should I need or desire more memory.
Notice that along the bottom edge of the RAM
module that there is a notch. This notch is designed
to prevent you from installing it backwards. Press
down on the top edge of the RAM module with firm,
even pressure, until the latches click along the sides

Securing the motherboard in the new case.

Installing the CPU cooler atop the CPU.
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of the RAM module. Repeat this process for each
RAM module you are installing.

Next, it’s time to insert and hook up the drives of
your system. For my particular build, I chose to use
a 32 GB SSD (Solid State Drive) to host my
operating system on. Most – if not all – the SSDs on
the market are 2.5” drives, which is the size most
commonly used in notebook computers. Built for
notebook computers, they traditionally don’t fit into a
desktop build. Fortunately, there are an assortment
of 2.5” to 3.5” adapters that allow you to install a 2.5”
drive into a desktop form factor. I chose the Icy Dock
(above), which allows you to place two 2.5” drives
into the space occupied by one 3.5” drive.

I also installed a multicard reader, along with two
DVD+/RW drives. To store my data, I installed a
Seagate 2 TB SATA 2.0 hard drive that my wife
bought me for LAST Christmas, which also
happened to be the first piece I collected for my new
build. She followed that up this Christmas with my
motherboard and video card.

The next items to be installed were the new video
card and HDTV tuner card. Carefully line up the card
connector edge with the card slot, and apply firm
and even downward pressure to seat the card into
the card slot. Be sure to secure the cards in place by
screwing them to the computer case chassis.
Since that was all of the items I needed to install, it
was time to close up the case and start installing the
operating system.

Firing It Up & OS Installation
Now it was time for the moment of truth.
Unceremoniously unhooking and disconnecting the
“old” desktop system, it was time to hook up the new
computer and slide it into the space vacated by the
old system. One press of the power button and –

Installing the RAM modules.

Assembling the 2.5" SSD into the IcyDock.

Securing the multicard reader in the 3.5" drive bay.

Installing the video card and TV tuner card.
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quietly – the new computer hummed to life. A blue
glow shone through the clear Plexiglas insert in the
side of the computer case and a the power button
was bathed in a blue glow. The screen displayed the
Gigabyte motherboard graphic. The phrase
“Searching for OS...” was subsequently emblazoned
boldly on the screen. Success!

I chose to install Phinx on my new computer. Even
though it’s a lighter version, I’m a real fan of the Xfce
desktop. Plus, installing a lighter desktop on my
more modern computer just means a faster
responding computer in the long run. While my new
computer is way more than capable of running a
flashy KDE desktop with all the flash, glitz and eye
candy, I feel much more comfortable with the Xfce
desktop. I find its simplicity very attractive.

I opened up the top DVD+/RW drive and placed the
Phinx 2011.08 installation CD in the tray. I closed
the tray and gave the system a “three fingered
salute” on the keyboard (Ctrl  Alt  Del) to cause a
reboot. Just a brief moment later, the Phinx grub
boot screen appeared. Confident that everything
would be recognized, I moved straight to the “Install
Phinx 2011” grub menu entry. I was very careful in
picking out my individual components, doing my
homework to make sure the components I chose
were compatible with Linux.
Another moment later, and I was at the hard drive
partition stage of the installation. Since both drives
were new, raw and previously unformatted, I
selected “Custom Partitions” so that I could set up
the partitions on the new drives. I set up a 4 GB
Swap directory (even though it’ll mostly be a waste
of space with 8 GB of RAM on the system) and the
remainder of the SSD as my root partition. I also set
up the 2 TB SATA II drive into four partitions, three
with 450 GB each, and the fourth with the remainder
(approximately 512 GB). The first 450 GB partition
was set aside as my /home directory, with the three
remaining partitions called data1, data2 and data3.
Less than 15 minutes after I started, the installation
of Phinx on my hard drive was complete. I removed
the installation CD and rebooted the computer. After
entering the root password and setting myself up a
user account, I was greeted by a clean Phinx Xfce
desktop.
The last time I installed Phinx on one of my
computers, it took me a solid week or more to get
the desktop set up even close to how I want it. I
have a list of personal tweaks (stored in my head)

that I customarily apply to my Xfce desktops
immediately after installation. These include setting
up various window manager themes, wallpaper,
launchers on the top panel, applications to start
automatically when my desktop loads, installation of
a core set of applications that I use, setting up the
graphical server, setting up the sound system, etc.
While I pretty much have my desktop set up mostly
like I want, my personal “tweaking” of the desktop on
my new computer is still evolving and ongoing. It
usually takes me three to four weeks to get
everything “just so.”
As is the case in many custom computer builds, I do
have some “issues” left to iron out. For one, TV tuner
cards are a hitandmiss proposition under Linux.
Nearly all of the manufacturers build their TV tuner

A view through the Plexiglas insert in the side of the
computer case.

My Phinx Xfce desktop, after some tweaks. Wallpaper
shows downtown Kansas City skyline at dusk.
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cards for Windows, often leaving users of “other”
operating systems out in the cold – or at best, with a
TV tuner card that only half works. Such is the case
with my new Hauppage 1250 HDTV TV tuner card.
First, the new TV tuner card does not work under
Linux with analog signals, such as the type sent to
the card from my cable converter box (tuning it to
channel 3, then using the TV tuner card to surf the
channels). In fact, I’ve discovered that it ONLY
works with purely digital signals, and even then, only
with MythTV installed from the repos. It seems that
MythTV is the only “TV” application that can properly
recognize the card.
I don’t know if the fact that it uses a PCIe 1x slot is a
part of the problem, but it’s appearing that TV tuner
cards using the older, plain PCI slot are better
recognized under Linux. Mind you, this is just an
observation, since I don’t have a lot to go on but the
reports in user reviews on Newegg.com and
Amazon.com. I wish I had realized this when I
purchased the Hauppage TV tuner card. It would
have altered my buying decision.
I will most likely be purchasing a HDTV tuner card
that uses one of the PCI card slots in the very near
future. Until then, I plan to install my old analog TV
tuner card (an old ATI TV Wonder Pro), so that I can
access the output from my cable converter box. I’ll
also be purchasing a separate aerial antenna to pick
up terrestrial OTA HDTV broadcasts on the
Hauppage 1250. In the end, I may end up giving the
Hauppage 1250 away to one of my friends who are
still stuck in the Windows world, where that particular
TV tuner card will work as it was designed to do.

Another issue I have to “iron out” is getting power to
my multicard reader. Since I hooked up four SATA
drives in my new computer, I ran out of SATA power
cables. My computer case had only four such
cables, so something had to give. I chose to leave
the multicard reader power cable unattached,
preferring instead to get the two optical drives and
the two installed hard drives running as they should.
So, I will also be purchasing a power splitter cable
very soon to enable me to deliver the necessary
power connection to the multicard reader.

Summary
While I’ve rebuilt many computers over the years,
this computer was my first build from scratch. I spent
the better part of a full year buying the parts, bit by
bit, as I could afford them. Over that time, I estimate
that I spent less than $700 on my new computer
system. Spread out over a year’s time, it makes it
much easier to build a system with the parts you
want, since you’re not spending large amounts of
money at one time – just a little here and there. I’ve
seen computers with fewer features selling for well
over $2000.
Overall, I’m very pleased with my new computer
build. What I find especially pleasing is NOT having
to pay the “Microsoft Tax” when you purchase a
new, preassembled system. Like many Linux users,
I’m through putting money into the Microsoft
corporate coffers. Before I discovered Linux, I
probably paid enough for Microsoft products over
the years to put one of Bill Gate’s kids through a
semester of college. No more. Regardless of
anything else, the fact that I contributed nothing else

to funding “the enemy” leaves me extremely
satisfied.

My new computer in its bay in my desk.
Answers to Mark Szorady's Double Take:
(1) Hair different; (2) Satellite dish different; (3) Hat
different; (4) Cord moved; (5) Shirt stripes different;
(6) Railing changed; (7) Small bush missing
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by Darrel Johnston (djohnston)

Periodically, questions come up on the forum about
configuring ClamAV after the installation. It seems
that almost everyone, myself included, has
encountered problems with getting ClamAV to work
properly after it’s installed. The default installation
issues should be addressed upstream at the
developers’ end. However, the configuration issues
have existed for years, and I’ll let sleeping dogs lie.
I’ll show you how I addressed the problems
encountered.

It was two or three years ago when I installed it for
use on a remastered CD I made for the purpose of
scanning Windows PCs for viruses. As a result, I
had forgotten some of what I had done to get
ClamAV working. So, I used the information from
some helpful PCLinuxOS forum posts to help me
along.
The first step is to open Synaptic package manager,
install any updates needed for your system, then
enter “clamav” as a search term (without the
quotation marks). Several packages will be
displayed. After marking the package clamav for
installation, the packages clamavdb and libclamav6
will be shown as dependencies. You should mark
them for installation, as well. The clamtk package is
a frontend GUI for clamav and offers convenience

for the user. The clamavmilter package is designed
for Sendmail. The package should be selected for
installation on mail servers, but is not necessary on
desktop PCs. The clamd package is a daemon
(system service that runs in the background) that
listens for incoming connections on UNIX and TCP
communication sockets and scans files or directories
on demand. Although the clamd package is not a
dependency of clamav, you should mark clamd for
installation, as well.
After installation of the clamav, clamtk and clamd
packages and all dependencies comes the fun part
of configuring ClamAV to work properly. The first two
tasks I did were to change the contents of
/etc/clamd.conf and /etc/freshclam.conf. These files
must be edited as user root. It is always a wise idea
to make backups of the original files before editing,
just in case. I took my cues from wolverine_tech in
editing the freshclam.conf file. He says:
For some reason, the config file for freshclam has
some 'necessary' lines commented out. I got it to
work by removing the # before some lines. Look for
those that do not have #.
1. I modified DatabaseMirror db.us.clamav.net. It
had a # at the beginning and was DatabaseMirror
db.XY.clamav.net instead of DatabaseMirror
db.us.clamav.net. (Use the appropriate country
code.)
2. I removed the # before DatabaseDirectory
/var/lib/clamav.
The contents of his modified file are listed in his post
in the Code: section.

Next, I took a shortcut and downloaded Leiche’s
clamd.conf file from here. I then copied it to the /etc
directory after making a backup of the original. For
reference, here is the change to be made. Towards
the top of the file are these two lines:
# Comment or remove the line below.
Example
Why the line “Example” is uncommented is beyond
me. Every other line in the file is commented but
that one! That line causes the rest of the file to not
be parsed at all. Comment the line by adding the #
symbol at the beginning of the line, or remove the
line altogether. There are no other changes
necessary.
At this point, freshclam, the CLI executable used to
update ClamAV’s virus database will not run. As per
forum user as, freshclam runs as user 'clamav'. You
need to allow write permissions for user 'clamav' on
the file /var/log/clamupdate.log. His solution is to
run the following two command lines in a terminal as
user root:
echo > /var/log/clamupdate.log
chown clamav:clamav /var/log/clamupdate.log
Instead of opening a terminal and entering the
command freshclam to update ClamAV’s database, I
opted to create a desktop file for that purpose. I
wanted to be able to run the desktop file from the
main menu. I opened a text editor and entered the
following:
[Desktop Entry]
Name=ClamAV Update
GenericName=Virus Definitions Update
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Comment=Update virus database
TryExec=freshclam
Exec=freshclam
Icon=clamtk
Type=Application
Terminal=true
Categories=GTK;GNOME;Utility;XMandrivaLinux
SystemFileTools;
StartupNotify=true
XDesktopFileInstallVersion=0.18
I then saved the file as clamdefupdate.desktop.
Then I copied the file to my
~/.local/share/applications directory. (The ~ symbol
represents, and is equivalent to,
/home/{yourusername} directory.) I then had two
new menu entries in the File Tools section, ClamAV
Update, (from the desktop file I created), and
ClamTk, from the clamtk package installation.

Next, I wanted to be sure that freshclam was
working, so I opened a terminal and entered the
command. I received the following error:
freshclam
ERROR: Can't create temporary directory
/var/lib/clamav/clamav
be560031acf6a1b994ab1fa84ba4dc16
Hint: The database directory must be writable for
UID 500 or GID 500
Hmmm. I’m user ID 500, and I’m the sole member of
group ID 500. At this point, I could have tinkered
with the settings in the /etc/freshclam.conf. I chose a
simpler route. I chose to make (only) the
/var/lib/clamav directory, its files and any
subdirectories readable, writeable and executable by
all. As user root, I issued the CLI command:
chmod R 777 /var/lib/clamav
Once done, the freshclam command merrily updated
the virus database definitions. (NOTE: If you elect to
create a desktop file for freshclam, launching the
desktop file from the menu will open a terminal. The
terminal may pause for a bit while reaching
ClamAV’s database servers. The terminal window
will close on its own once all steps have completed.)
As user margarita has pointed out, freshclam’s
database can be stored in your home folder, with all
updates written to the stored database file.
I use that as user:
/usr/bin/freshclam datadir=$HOME/.clamtk/db
< (all log=$HOME/.clamtk/db/freshclam.log #
clamtkdefs < one line)

/usr/bin/clamscan database=$HOME/.clamtk/db 
detectpua i r $HOME < (all
excludedir=$HOME/.clamtk/viruses 
log=$HOME/.clamtk/history/$(date < (one +\%b
\%d\%Y).log 2>/dev/null # clamtkscan
< line)
There are a few possible solutions to the problem of
configuring ClamAV to run after installation as forum
user as has pointed out in this forum thread,
So now you have 3 solutions, but no one is an
upstream solution.

ClamAV Installation and Configuration
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by Texstar
This tutorial will walk you through setting up a simple
shared folder in your home directory.
Open Dolphin
Create a new Folder called Shared in your home
directory
Right click on the Shared Folder
Click on Properties
Click on Permissions
Click on Advanced
Check all 6 boxes
Click OK
Click OK

Open Synaptic
Click Reload to get a current file list
Click on Search
Type in tasksamba
Right click on the tasksamba
Mark for installation
Click Apply
Close out Synaptic after transaction is complete

Open Configure Your Computer
(PCLinuxOS Control Center)
Click on Network Sharing
Click on Share drives and
directories with Windows (SMB)
System
The Wizard will start.
Select Standalone  standalone
server (top right)
Click OK

Workgroup type mshome
Netbios name type sambaserver
Click OK

Simple Samba Setup Under PCLinuxOS KDESimple Samba Setup Under PCLinuxOS KDE
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Security Mode  Select Share
Host Allow  type 192.168.1. (Please note all of my
network computers use 192.168.x.x)
Click OK.

Server Banner
Click OK

Samba Log
Click OK

Final Status Wizard page
Click OK

Congrats to you. The Wizard has configured your
Samba Server
Click OK

File Share Tab
Click on Modify
Click on Open
Select the Shared folder you setup earlier
Click OK
Add Yes to Public, Writable , Browseable
Click OK

Click on Samba Users Tab
Click on Add
Select Nobody (next page)
Leave the password field blank
Click OK

Simple Samba Setup Under PCLinuxOS KDE
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Click on the Samba Server Menu Item next to File
Select Reload
Select Restart
Click OK

While still in the Control Center go to System >
Manage System Services

Scroll down to SMB (right)
It should show as running
Check the box to On Boot
Click OK
You can now close out the PCLinuxOS Control
Center.
To test copy some files into the Shared folder.
Go to another computer on the network (sorry no
Windows here)
Open the Konqueror File Manager from the menu >
File Tools
In the URL bar type smb://sambaserver/homes
There is your shared folder with files! \O/
For Dolphin Click on Network
Click on Samba Shares
Click on mshome
Click again on SambaServer
Click one more time  on Homes
There is your shared folder with files! \O/
Holy crap you did it!

Simple Samba Setup Under PCLinuxOS KDE
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by Ralf Vöpel (DAGAZ)

What is cron?
cron is a daemon that executes scheduled
commands. Cron wakes up every minute, examining
all stored crontabs, checking each command to see
if it should be run in the current minute.
An example of crontab format (with commented
fields) is as shown at the bottom of the page.
Do not worry, since vcron does all of this for you.
And then there is the command 'at'.

cron vs at
The command 'at' runs a command ONCE at a
specified time on a specified date, whereas ‘cron’
allows you to run the command or script repeatedly
at different minutes, hours, days, monthly or on
different weekdays.

Vcron?
V stands for visual and as all GUI's do, it makes life
easier and takes a lot of 'syntax' off your hands. In

short, vcron is a front end for cron. Install vcron via
Synaptic. Once Synaptic is done, you will find it
here: Application Launcher → More Applications →
Accessibility → Visual Cron.
Welcome to Visual Cron, scheduling made easy.

This is how vcron initially appears and we are about
to change it. But first, let us familiarize ourselves
with the GUI.

The Operations Menu:
As you can see (top, next column), clicking on
Operations shows the same selections as those at
the bottom part of the Visual Cron window.

The Configuration Menu:

Set cron environment allows you turn on/off email
notifications and more. We do not need to change or

Sample commented crontab input

VCRON: A Visual Interface For cron & atVCRON: A Visual Interface For cron & at
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add anything here. However, if you want more
details visit: http://adminschoice.com/crontab
quickreference.

Set language:
You guessed it. You can change the language on
the fly, meaning you do not have to restart vcron.
Now is this not cool?

Now, it’s time to add a task. First click on Add. You
will be asked what kind of cron job/task you want to
create. Remember the difference between cron and
at?
We are going to create a cron job which
synchronizes our /home folder with a NAS (Network
attached storage) device. You can, of course, sync
any folder to any device or any folder.

Click regular and the next window shows up.

In the Minutes column click 0, Hours 3, Days Any,
Months Any, Weekday Sunday. Click into the Field
'Program to execute:’ and type in:
rsync a delete /home your_server_ip_or_
folder/where_to_sync_folder.
The example above means:
run rsync at 3:00am every Sunday, archive the
/home folder as root on a NAS with the network
address 192.168.0.130 in the folder/ DataVolume/
laptop AND delete every file on the destination
server that does NOT exist anymore in the /home
folder. If you do not have a NAS device, you can

modify the command to: rsync a delete /home
any_drive/any_folder. Click OK.

Congrats, your first cron job has just been created. It
shows up under regular programming and from now
on, the task will be done every Sunday at 3:00am.
If you have your own script(s) and you want it/them
to be executed automatically, use vcron to set time
and date and your trusty PCLinuxOS box will take
care of it.

Vcron: A Visual Interface For cron & at
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Here is how to get your program or script automated:
Instead of typing the command into the Program to
execute field, click on Add, then Browse, locate
your program or script and click Open.

Voila! There it is. licoupdate.sh updates my status
on linuxcounter.net.

Now what about the One Shot Programming ‘at’?
The command ‘at’, as we now know, runs a job only
once. So what is it good for?
Let us say you want to shutdown your machine on
April 2, 2020 at 3:30 AM. Click Add, select one shot
(at), click the required minutes, hour, day etc.,
browse for shutdown, the program to be executed
(/sbin/shutdown) and add /sbin/shutdown h now.
Click OK.

Now your one time job is in the list under One shot
programming.

We now have 2 jobs that will run from now on at the
set date and time until we modify or delete them and
we have 1 job that will run in 2020 ONE time. To
delete, modify or view a certain job, click on the job
in the list and then click the wanted “action” button.

!! Important !!
Vcron creates the cron job for the current user. If
you want vcron to create jobs for ROOT or another
user, you need to open a Terminal, su to root/other
user and call vcron from the Terminal. You also
need to have the rights to execute the scripts or
commands you want to run.
Have fun with Vcron. Consider it crontab e without
the headache.

Vcron: A Visual Interface For cron & at
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by Archie Arevalo (Archie)

It seemed like just any ordinary day when I would
visit bookmarked sites like free (Code),
SourceForge, KDEApps, QtApps, etc., and was
making my usual selections of reading about new
and updated apps. It just happened that I read and
downloaded an image viewer app called Photo. The
reviews were encouraging but it was such a new
app that rpm.pbone doesn't even list an RPMbased
distro that had packaged it.
It was easy enough to write a spec file for it, and it
built flawlessly  no errors and exit 0s at all!
So, I began testing it. The first thing I noticed was it's
small file size. At 136.6 KB, I thought it would be
another app that I'd redirect to trash://.
It was a minimalistic app, 1 point. On launch, it
opened the File Open window, which was the next
sensible action for using the app, 2 points. It
displayed my selected image and it didn't take long
to generate thumbnails of the couple of hundred
images I had in that particular folder. It was fast! 3
pointer!
The next thing I did was I posted a comment to the
app's page on QtApps, stating I have packaged the
app and would send it upstream to our head
developer for consideration and inclusion on the
official PCLinuxOS repository. I also asked about the
icons.

What icons? A reply was almost immediate.
And this is how I met Lukas Spies, the lone
developer of Photo.

Lukas was originally from the southern city of
Karlruhe in Germany who is now studying
Mathematical Science at the National University of
Ireland in Galway.

Reaching Out In FriendshipReaching Out In Friendship
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I asked him if he would like to be interviewed for the
PCLinuxOS Magazine. This is his first ever and he
thought it would be pretty cool.
What got you started with Photo?
"I saw some friends using Google’s Picasa and I
really liked the way the images are presented. I
looked around and tried all different types of image
viewers to find one, that does not only do its job
properly but that also looks nice and neat. There are
a lot of good image viewers out there, that can do a
lot of things but most of them aren't necessarily first
choice for presenting images.
"Last December, 2011, I played a bit around with
C++ and Qt, more as a proof of concept to myself; to
show that it's possible to do something like Photo. I
originally didn't even intend to publish the app in any
way, but eventually decided to upload it at Qt
Apps.org and see what happens. Within a few days,
I got some really good feedback from people who
really liked it.
"Looking back at my surprise, the first version really
was very, very basic. The interest motivated me to
continue developing it. Every new release since then
I got more feedback and encouragement. It really is
somewhat satisfying to see people liking and using
something you created.”
What are your goals for it?
"I just hope to continuously work on it and improve it,
until  well, I don't know until when or what. I didn't
start developing it with some final idea in mind. Of

course, there are some things I want to achieve and
features I want to implement. And it would be really
cool, to see it some day becoming maybe the
standard image viewer. Well, I think, that pretty
much everybody that does some programming
hopes one day to have programmed a "standard

application". But, I actually do see potential for that,
but that's not what I'm primarily working for. The
main thing for myself is to enjoy the programming I
do ... not feeling stressed out or stretched by it.”

Reaching Out In Friendship
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What do you do when you're not working on your app?
Tell me a bit more about yourself ... social life,
relationships, favorite music and film, etc.
"I'm sharing a small house with four other friends in
the west of Galway. It's maybe not the nicest area,
but I do like it here (mainly because of the people I
live with). Besides working on my app and university,
I'm leading a small Christian youth group called
"Ambassador Youth", a bit more than half an hour
outside of Galway, in the town of Tuam. The youth
group is part of a church called Corner Church. I
started volunteer work in September last year, and I
really love it!
"Together with some others, I'm also trying to get
some youth work started here in Galway, where I
live. In the university, I'm also part of a leadership
committee for the Christian Union Society, taking
care of technical stuff and finances. That's where I
spent almost every Wednesday evening. And we do
a lot of stuff also during the rest of the week (movie
evenings, bible studies, just hanging out, etc.), which
are always great fun.
"A big (although fairly new) hobby of mine is
trekking. I just love to go out there for a week or two
with a tent and just walk and see amazing things.
Every summer, I plan and hope to get at least once
out there for a good while.
"And last, but not least, I enjoy making music. My
primary instrument is the accordion although I sadly
don't have one over here in Ireland. Besides the
accordion I play a little bit of panpipe and also a bit
didgeridoo. I obviously like slightly more exotic
instruments. My favourite band is called "Kutless",

an American rock band. I really like their style and
the type of songs they sing. I'm not that big into
watching films or movies, but I do like the actor
Terence Hill and his films a lot.”
What OS are you using? Have you tried PCLinuxOS?
What are your computer specs?
"I started out my Linux experience more than six
years ago with openSuse, that a friend gave to me in
school. About three years later, I switched over to
Arch Linux (64bit), which I'm still using today. My
WM is KDE, but for a good while I also used LXDE.
But KDE definitely is my first choice today.
"I have to say, that I haven't tried PCLinuxOS myself
yet, but I did hear some good stuff about it from
others using it. I certainly would recommend it to
other (new) users.
"I have an Acer TimelineX 4820TG laptop. Some
specs for it are:
Intel i5 480M
AMD Radeon HD 6550M
14'' screen
4 GB DD3
750 GB harddrive
long battery life”
How far would you take Photo? What are you future
plans for it? Are you involved in any other projects?
“Well, I certainly hope to take Photo as far as I can
and keep on improving it. I really want it to be
something nice, simple and good looking  easy to

use. But at the same time I want to keep it highly
configurable and adjustable to personal needs. I
want Photo to be perfectly usable "out of the box"
without having to adjust a lot of annoying settings.
But it certainly is worth having a look at the settings
and especially the many shortcuts that are available.
"There is indeed another project I'm involved in. It's
not a desktop app: a javascript unit converter, that
aims on being fast, being usable without having to
click or reload the page, and to look nice at the
same time. You can find it here:
http://luspi91.cuccfree.com/. It's working pretty good,
but it wasn't tested in that many browsers yet. But
I'm also continuously working on improving it.”
You are now programming in Qt, are there any specific
reasons why you chose Qt?
"After I started learning C++, I wanted to do "cool
stuff", graphical programming. Qt was the first
graphical framework I found through Google. I read
some stuff about it and it looked pretty promising, so
I started to learn it from a book from our local library.
It took me a long while, but I slowly learned more
and more. I really like it today, cause it's a pretty
neat and working framework for graphical
programming. That's also why I used it for Photo.
And last but not least, that's the only graphical
framework I know how to use for programming. I
never did anything with Gtk or something else,
cause I never needed to. Until now, Qt always
worked perfectly for me, that's why I used it also for
Photo.”
Do you use any other computer programming language?
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"I started my programming adventure more than six
years ago with Php and HTML, and soon after
Javascript. Some of my friends in school were

learning it, and I thought that was pretty cool and
wanted to do it as well. So I went to our local library
and got a big book about Php and started learning. It
wasn't always easy and I had some longer breaks in
it where I had lost my motivation, but I kept coming
back and trying again. And eventually I got a hang of
it, I set up a little website where I was trying out all
different things. After about two and a half years I
started learning C++, shortly after followed by Qt.
Since then I've learned more and more about it, tried
different stuff, programmed smaller things for myself,
and I really got to like it a lot.

"Most of the programming I did was just playing
around, trying different stuff, seeing how this or that
works, trying to write little apps that didn't really work

or that were "meant
to be senseless." I
tried myself on a Qt
interface for
Streamripper,
extended by Phonon
and Mplayer
functions, but I
stopped doing stuff
for it about half a
year ago (although I
think, the
sourceforge page of
it still exists). Maybe
I will "resurrect" the
project at some
stage in the future
again.
"One and a half

years ago I learned a bit of Python at the university.
It's a fairly simple programming language (at least
compared with C++), but I somehow don't really like
it. I probably would have never started with it, if I
didn't have to for my course. And I do know some
basics of bash programming, just the amount you
need for daily use.”
Often projects involve a group of developers
collaborating on the different components. You seem to be
working on Photo all by yourself (with the exception of
the translators listed on the app's info window). Do you
have any plans on collaborating with other developers
either on the Photo app or another?

"Well, Photo started as "playing around with code,"
without the real intention to do some proper app.
That's why I'm currently developing it on my own.
Although I'm open to help, I'm not (at least currently
not) actively looking for help, cause it's not yet that
complicated, and I do have more than enough time
for it. I really like it for getting my maths out of my
mind for a while and focu[a]sing on something else.
"If I'll ever be starting or helping with another project,
I don't know. I'm not too sure if I'll be able to do more
than the two projects I'm working on right now,
simply because I probably wouldn't have the time, I
have enough other things going on. The main
purpose of programming for me, is to have fun in
doing it.”
What do you think is the most important thing when
starting a project?
"I think the most important thing when starting a
project is definitely not to get discouraged! The start
usually is very slow, and it takes time until people
find out about your project. It's easy to give up after
a couple weeks, because nobody seems to use it,
and because you didn't get feedback back. I think it's
really important to stand through these times,
because when people notice that you are
continuously working on something, they are more
likely to have a look at it.
“Another important thing is to have a rather short
release cycles with each rather few changes than
only once in a while a big release. Showing that a
project is alive is vital for it to become something
longterm.”
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by Gary Ratliff Sr. (eronstuc)

My adventures in buying computers have been
many. I bought my first PET in 1978 and had to go
out of state to do so, since they had not yet reached
Mississippi. Then, when Dr. Dobbs' accepted my
first computer article, Just Poking Around with my
Pet, I knew I was to be a computer journalist. Soon,
articles followed in kilobaud, PC Computing, and
COMPUTE!. Then the folks at IBM introduced the
PC and thought they had invented the personal
computer. I wrote my very best article and received
a rejection slip, since people wanted to read about
the PC and not the PET! I vowed I wouldn't touch
one of these with a ten foot pole!
Soon, I saw the folks at work struggling with a
project, and told them I could save them money by
writing a computer program to solve the problem. I
was given a list and told to write down what I
needed. Soon, a machine that I could only dream
about was sitting on my desk. Later, I learned
FOCUS and wrote some data entry files. The
corporate programmer was now out of a job, since I
soon took her place providing the programs needed.
Later, I was assigned data entry over the network. I
soon became familiar with the workings of Novell
Networks. The department wanted a more up to
date system, and I saw an ad for a 486 system
named Cardinal. It seemed to offer the best buy for
the buck. All used it except for the QC Manager,
Tom Kent. He told me I should always buy from HP,
since their equipment was the most reliable.
As the years passed, I made an effort to always buy
my systems from them. As you know, my main
system was until recently an HP Pavilion a1253w

system. Now the systems are reliable and have
caused no problems. The only fault I have with them
is that once the warranty is out, they don't provide
answers any more. The USB ports on the front of
the system had all “given up the ghost.” The
holder for the Flash Card had come loose
and it was clearly time for a new machine,
despite the addition of the SATA drive.
My ability to purchase a new computer is
due to WalMart possessing a little Christmas
spirit and allowing layaway for certain
merchandise for the three months prior to
Santa's arrival.
I looked at the options and again let the
dollars make my choice. My selection was
the eMachine from WalMart, which had a 1T
byte hard drive and offered 3 gigs of
memory, no monitor, and all for less than
$300. Soon, I had set up the layaway
account. I only had to make an additional
three payments before I could take it home.
One by one, the payments were made, and
the big day arrived to go get my computer.
I hauled it home and went to put it up and surprise, it
was the wrong computer. This one was $100 more
and had included a LCD monitor. After waiting three
months, I set it up and it only had 2 gigs of memory
and a 320 gig hard drive. So, I decided I would take
this computer back and swap it for the correct
model. However, since I can only get to the store
once a week, I had at least a week before I could
return it.
Finally, just two days before Christmas, I had the
computer I had actually determined offered the best
buy for the buck  a brand new eMachine EL 1358G

51W. I soon set up my system and moved the 2T
FlexDrive to the system. By enabling sharing, I could
use this with my HP system, which was in the
computer room.

Note the contrast in size between the newer
computers with only SATA drives and the older
towers. You can see the Seagate 2T GoFlex drive
and the HP Deskjet 1000 mentioned in my
December article. The new computer is called
Gabriel, and replaces the older Gabriel, which is to
the right. Beside the old Gabriel is Michael, which
was my brother Dave's computer. It runs Windows
95 and has 16 megs of memory. It still functions
flawlessly. Perhaps what has kept it safe is that I
can't figure how to open the case!
In the last issue of the magazine, there was a picture
showing the inside of the HP computer with both
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PATA and the new SATA drive showing. Compare
that with the more compact inside view of the new
machine:

Gone are the wide ribbon cables. The cables for the
SATA hard drive and DVD drive are smaller around
than a typical power cord. The system also has a
dual core processor, which greatly speeds up
operations. Windows 7 has borrowed many items
from Linux. It actually insists that you set up a
password. Actually, the trial of the first system,
before I returned it, was quite embarrassing! I
actually forgot the password and was unable to get
into my earlier eMachine.
The only thing that saved me was that I had followed
instructions and created a complete set of recovery

DVDs. As I was trying to remember the password
and being rebuffed, the machine told me that I
should have created another drive, which would

provide a clue as to the password. It’s funny
that they forgot to mention this item. The
recovery process brought the machine back
to the enter password selection, and this
time I wrote it down.
I have been very happy with the new
computer. Before closing the article, I want
to mention another item which should
appeal to video buffs. While watching TV, I
happened to switch for a few minutes to
QVC. They were demonstrating an item
called the Roku HD. They were offering the
system for four payments of only $19.99.
What the Roku HD does is bring in
channels from the Internet to either your
high definition or standard TV. The
standard TV will need the stereo
and video RCA jacks, which attach
to the Roku through a special jack.

You set up your account information
through your computer, and the device
uses the wifi of your router to reach the
Internet. You just select the channels you
wish to view and the items appear on your
TV. There are TV shows, movies, Pandora
and other radio providers, and games which
may be sent to your TV.
If you need more channels than your cable
system allows, you will love this item. The
sale from QVC is over, but you may
purchase one directly from Roku.

If you can’t follow the previous link, just do a Google
search on Roku to learn how.
As you can see below, the Roku is very small (sitting
on the top left of the small table). The shown cable is
the one provided by the default system, which goes
to a standard TV. By connecting it to a VCR, DVD
Recorder, or digital PVR, it is possible to save the
movies, which you download from the Internet. Here
again, this is possible using what is becoming an
obsolete technology. Its redeeming feature is that it
works.
I’m planning a future article, featuring a tutorial on
how to use Dolphin to store your files on the GoFlex
drive.
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by Paul Arnote (parnote)

There is no shortage of sound applications that have
been specifically written for (or centered around) the
Gnome desktop environment. Of course, many of
these applications can be used in other Linux
desktop environments, as well.
The criteria for inclusion as part of a Gnome 2.32
article was a) the description in Synaptic, b) being
listed on the Gnome project site’s Module
Maintenance list, c) significant Gnome
dependencies listed for a package in Synaptic, or d)
my prior knowledge of a project belonging to (or
catering to) the Gnome desktop. For example, the
Python/Gtk+ app Exaile is a favorite of many users.
But, it is not included because it’s not dependent on
Gnome. If your favorite app isn’t listed below, it’s
simply because it didn’t pass muster when the
aforementioned criteria was applied.
So, without dillydallying around any more, let’s look
at the Gnome sound apps.

Banshee
Closely associated with Gnome, Banshee is a
free/open source C#/Mono application, using the
Gnome technologies and SQLite. It attempts to
position itself as the “goto” application for all of your
multimedia needs, playing CDs, DVDs, digital music
files, podcasts, Internet radio stations, audio books
… and just about any other multimedia format you
can think of.

Unfortunately, Banshee in the PCLinuxOS repository
is broken (at the time of this article being written),
and will not launch on my copy of Zen Mini 07.11.
You can check out more information about Banshee
by checking out the Banshee home page.

gnac: Gnome Audio Converter

Don’t let the simple interface fool you. This
application does one job – sound file format
conversion – and does it well. To get started, click
on the “+” icon and select the file(s) you want to
convert. If you make a mistake and want to exclude
one of the added files from the conversion process,
highlight the file and click on the “–” icon. To
completely clear the list of queued files, click on the
broom icon.
Next, click on the drop down list in the lower left
corner, and select the format you want to convert to.
If the format you want to convert to isn’t listed, or if
you want to see what parameters are applied, select
a similar codec to use and click on the “Edit” button.

Image courtesy of the Banshee web site.
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You will see a list of the predefined “profiles” listed in
a dialog box similar to the one shown above. Select
the one you want to alter (or select the “New” button
on the right), and select the “Edit” button on the
right.

Using the “Edit Profile” dialog box (shown above),
you can enter all of the variables that control the
conversion of your sound file to the selected format.
Of course, different options may be presented with
different formats, dependent upon what options your
selected format supports.

Selecting the Edit > Preferences menu item will
display the dialog box above. Set the general
operation preferences for Gnome Audio Converter
here. The “Audio” tab allows you to set a couple of
options for how your converted sound files are
saved. The GAC home page will fill you in on more
information.

gssmp: Gnome Simple Stateful Music Player
With “simple” as part of its name, the Gnome Simple
Stateful Music Player is exactly that. To start with,

you need to choose the music you want to play. If
you want to play all of the songs in a directory,
simply choose the File > Play Directory menu item.
GSSMP will start playback of the first audio file it
finds in the selected directory, then proceed through
the other audio files there, alphabetically. If you want
to play a specific file, select the File > Play File
menu item. Then, select the file you want to play.
You can also sync your music listening preferences
with last.fm, if you choose, via the “Tools” menu.
GSSMP also remembers the last file you were
playing, and will allow you to directly access it via
the “Recent” menu, in case you had to shut down
GSSMP before you completed the playback of the
file. The rest of the controls in the application
window should be fairly self explanatory. The
GSSMP home page will provide more information for
you.

gwc: Gnome Wave Cleaner
If you are one of the many MLU’s (Mature Linux
Users) in the PCLinuxOS forum, you most likely
have a fairly extensive collection of music on vinyl
records. I know I do. My wife got me a USB turntable
as a present Christmas before last. In my leisure,
I’ve been converting my old vinyl records to MP3
files that I can play on my assorted MP3 players and
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on my computer. No matter how hard you try, you
cannot get rid of all the microscopic dust particles,
not to mention the years of wear from listening to
your vinyl records over and over again. Vinyl records
DO wear out with repeated playings. Invariably, you
will be left with a recording of your vinyl record tracks
that contain “pops” and “clicks.” These are the direct
result of all of that wear and microscopic dust.
Enter GWC, also known as Gnome Wave Cleaner.
It’s primary purpose is to automatically detect those
“pops” and “clicks,” and remove them from the
source file. You can run it once to get rid of the
strong clicks, then again to scan and eliminate the
weaker clicks. I recommend listening to the file after
the first pass – you may be satisfied with the results
after eliminating only the strong clicks.
As anyone who has worked with making digital
copies of their vinyl music collection can attest to,

old vinyl can also develop a “crackle” in the
background that can also detract from having a
clean digital copy. Fortunately, GWC also has the
ability to remove that background “crackle” sound.
Keep in mind that GWC only works on sound files in
the *.wav format, which is a good thing, since it is
pretty much a universal lossless sound format. So, if
you have recorded your vinyl tracks as MP3 files,
you will need to first convert them to the *.wav
format. Don’t worry – GWC will allow you to later
resave your edited sound file as a *.mp3 file.
Prior to performing any action on your sound file, I
recommend clicking your mouse on the black bar
that separates the two sound channels (in a stereo
file), then clicking on the “Select All” icon on the
toolbar (next to last icon on the toolbar, at the upper
right corner of the GWC window). This way, you will
insure that both channels of your stereo file are
analyzed for the editing you wish to perform.
Otherwise, my initial use of GWC resulted in only the
left channel being declicked, leaving the right
channel untouched. Needless to say, I was still
hearing “clicks” and “pops” in my sound file after
attempting to remove the clicks, because the right
channel had not been cleaned.
GWC can also “denoise” your sound recording, as
well as amplify your file. Most other sound editing
functions can be done with a more complete sound
editor, such as Audacity.
Just as many other Linux applications, GWC does
one job, and does it exceptionally well. Let your ears
be the judge. I know that I could certainly hear the
difference. I picked a song that I thought might give

GWC difficulty (Sammy Hagar’s “I Can’t Drive 55”).
However, GWC processed the file admirably and
without any difficulty. GWC definitely deserves to be
in your sound file editing and processing toolbox.
Check out more about GWC by visiting the GWC
home page.

Listen

Written in Python for Gnome, Listen is a quite
capable music manager and player. With Listen, you
can playback your favorite songs, manage your
music library, manage your iPod, make playlists,
download album covers (and sync them with your
iPod), burn an audio CD, retrieve data from
Wikipedia when you play a song, view the lyrics of a
song, retrieve statistics about your favorite songs,
albums or artists, listen to web radio stations, and
access to your last.fm account.
The latest version (0.6.5) is in the PCLinuxOS
repository. While it can be used under other desktop
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environments, be forewarned that it will pull in a
significant number of Gnome dependencies. You
can visit the Listen home page for more information.

SoundConverter

Despite its simplistic appearance, Gnome’s
SoundConverter is a powerful tool that automates
conversion of various sound file formats.
SoundConverter can read any input sound file that
can be read by gstreamer, and output it to WAV,
MP3, OGG, FLAC or AAC formats. You can specify
the output format by selecting the Edit > Preferences
menu, and changing the output format in the

preferences dialog box. Additionally,
SoundConverter can extract the audio from video
files.
Written in Python, SoundConverter is a
multithreaded application, that will use as many
cores available to perform the file conversion as
quickly as possible. Because of its multithreaded
design, SoundConverter will convert multiple files
simultaneously, placing each conversion process
into its own thread. Visit the SoundConverter home
page for more information.

SoundGonverter

Soundgonverter is a sound conversion application
written in Mono, the Linux equivalent of the Microsoft
.NET application framework that utilizes the C#
programming language. Unfortunately, I can’t report
very much about this application, since the version

that is in the PCLinuxOS repository produces a
segfault whenever I attempt to run it. You can visit
the soundgonverter home page for more
information.

RhythmBox

Taking its inspiration from Apple’s iTunes,
Rhythmbox is a Gstreamer application built for the
Gnome desktop. Rhythmbox bills itself as more than
a music player. Rather, it bills itself as an integrated
music management application – and probably
rightly so.
So what can Rhythmbox do for you? For one, it can
play your music collection on your computer, as well
as organizing it and allowing you to search and sort
through the songs in your collection. It can also sync
your music collection with your iPod or other MP3
music player. You can also burn audio CDs, listen to
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Internet radio stations, listen to last.fm music
streams, create playlists, download and view song
lyrics and album covers, and display audio
visualizations.
Additionally, there are several 3rd party plugins for
Rhythmbox, that further extend the capabilities of
Rhythmbox. These plugins range from graphical
equalizers to adjusting the pitch and speed of your
songs. To get the full lowdown on Rhythmbox, as
well as a link to the 3rd party plugins, visit the
Rhythmbox home page.

Nautilus Sound Converter

A product of a Google Summer of Code project,
Nautilus Sound Converter is almost identical to the
Gnome Audio Converter (GAC) – except, it’s a
Nautilus extension. In fact, Nautilus Sound
Converter uses the same configuration file as GAC.
As such, Nautilus Sound Converter works exactly
like GAC, which we talked about earlier in this
article. The Nautilus Sound Converter home page
has more information.

Summary
As you might expect, Gnome 2.32 has a plethora of
sound applications to fit your sound file needs. While
it’s true that we left out some sound applications that
are popular with Gnome users, such as Exaile, we

did so because Exaile is not developed specifically
for the Gnome desktop environment. Even without
Exaile, the Gnome desktop has plenty of other
sound applications to fulfill your sound application
needs.

Screenshot ShowcaseScreenshot Showcase

Posted by bones113, January 14, 2012, running KDE4.
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by Patrick G Horneker (phorneker)

PCLinuxOS is an easy to install and maintain
distribution for everyday use. Installation consists of
a LiveCD image that is written to a CD/DVD disc, a
USB flash drive (2GB or larger), or a memory card
with at least 2GB of capacity, preferably larger.
If you are using the Full Monty distribution, you will
need to use a blank DVD or flash drive with at least
4GB, preferably more because of the size
of the disk image (about 3.2GB).
When you install PCLinuxOS from a disk
image, what you get is enough to get a
basic system running. Generally, you
would need to use a high speed Internet
connection to do an initial update (using
Synaptic) first, then install any and all
software you need from the repository (or
any if its mirrors).
But what if you are installing
PCLinuxOS on a machine that has a
dialup connection, or worse, a machine that is
not connected to the Internet?
As of this writing, there are 171 packages for the
initial update. On a 56K dialup connection, the initial
update would have to be done overnight as it would
take several hours to download and install the initial
updates.
Yes, there are still a number of dialup Internet
connection providers around, usually costing about
$10.00/month on average. For some people, this is
the only way to connect to the Internet.

After the initial update, you might want to install
additional packages, right? If you have a 56K dialup,
you would have to either tie up the phone line for
several hours, or go to a local cybercafe and use
their WiFi connection.
There are two ways to get around this problem.

Full Monty Distribution

The first solution is to get a copy of the Full Monty
edition of PCLinuxOS. This is a 3.9GB image of a
standard KDE installation, a very organized layout
with six desktops, and loaded with most every
application you would want installed on the disk
image.
Without an Internet connection, you will not be able
to do an initial update, but you have a nearly
complete system containing most anything you
want. I say nearly complete because some
multimedia codecs are not installed by default (due
to licensing restrictions on the codecs).

Get The Repository on DVDs

It is possible to get the PCLinuxOS software
repository as a DVD set. Vendors such as
osdisc.com sell a six DVD set containing the entire
PCLinuxOS repository (at this writing contains
updates through January 19, 2012).

It is with this set that you can install a
complete PCLinuxOS system without
having to rely on a high speed Internet
connection. You will also need to order a
Live CD, since the repository DVD set
does not include a Live CD for installation.

Another Case Where This Would Be Useful

Imagine one day not being able to access your
favorite repository with Synpatic (due to Internet
censorship). Having the DVD set is handy if you ever
have to reinstall PCLinuxOS without access to the
repository. You may not have the latest updated
packages, but at least you will have a working
PCLinuxOS system.

Networkless PCLinuxOS InstallationNetworkless PCLinuxOS Installation
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ms_meme's Nook: Some Morems_meme's Nook: Some More
PCLOS my pretty little OS
You make my desktop sweet and heavenly
You are my chosen my 'puter's never frozen
Now it runs magnificently
PCLOS my pretty little OS
Texstar made you with such charm
PCLOS PCLOS
You keep my files and folders from harm

Some More Some More Some More
Texstar is neat I must repeat we all adore him
Give us More Some More Some More
His OS sweet none can compete we don't ignore him
Some More Some More Some More
For each update we cannot wait we all implore him
We want More Some More Some More
Praises I bring and that I sing are just for him

MP3 OGG

http://pclosmag.com/html/Issues/201202/files/somemore.mp3
http://pclosmag.com/html/Issues/201202/files/somemore.ogg
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by Darrel Johnston (djohnston)

Sun Microsystems was started in 1982 to further
develop the project born at Stanford University. The
acronym (SUN) itself stands for Stanford University
Network. Cofounder Bill Joy was one of the leading
UNIX developers of the time, having contributed the
vi editor, the C shell, and significant work on the
TCP/IP stack to the BSD UNIX OS. Sun's first
workstation shipped with UniSoft V7 UNIX. Later,
Sun began providing SunOS, a customized 4.1 BSD
UNIX, as the operating system for its workstations.
In the late 1980s, AT&T tapped Sun to help them
develop the next release of their branded UNIX, and
in 1988 announced they would purchase up to a
20% stake in Sun. UNIX System V Release 4
(SVR4) was jointly developed by AT&T and Sun.
This partnership triggered concern among Sun's
competitors, many of whom banded together to form
the Open Software Foundation (OSF). By the mid
1990s, the ensuing UNIX wars had largely subsided,
AT&T had sold off their UNIX interests, and the
relationship between the two companies was
significantly reduced.
Sun used SVR4 as the foundation for Solaris 2,
which became the successor to SunOS. Solaris is
known for its scalability, especially on SPARC
systems, and for originating many innovative
features such as DTrace, ZFS and Time Slider.
Solaris supports SPARCbased and x86based
workstations and servers, and is registered as
compliant with the Single UNIX Specification. Solaris
was historically developed as proprietary software.
In June 2005, Sun Microsystems released most of
the codebase under the CDDL license, and founded

the OpenSolaris open source project. With
OpenSolaris, Sun wanted to build a developer and
user community around the software.
In the first half of the 2000s, Sun was too slow in
turning Solaris from a closed to an open source
product. This lost the company the server segment
in enterpriselevel deployments. Some studies
indicate that if Sun hadn’t been so conservative, it is
possible that a large part of the server segment
would now be OpenSolaris hosts, rather than Linux.
OpenSolaris took another blow when Sun, in a bad
financial condition, was bought by Oracle in January
2010. After the acquisition of Sun Microsystems,
Oracle decided to discontinue the OpenSolaris
distribution and the development model. Oracle can
hardly be called an open source friendly company,
so it wasn’t surprising when the OpenSolaris
community decided to develop their own fork,
independent of Oracle’s corporate games. As a
result, the OpenSolaris community forked as the
OpenIndiana project in 2010, a part of the Illumos
Foundation. In August 2010, Oracle discontinued
providing public updates to the source code of the
Solaris Kernel, effectively turning Solaris 11 into a
closed source proprietary operating system.
However, through the Oracle Technology Network
(OTN), industry partners can still gain access to the
indevelopment Solaris source code. The open
source portion of Solaris 11 is available for
download from Oracle.
OpenIndiana comprises the Illumos core, taken from
OpenSolaris, with a set of GNU userland tools.
OpenIndiana can even be called an analogue to
GNU/Linux. But, instead of a monolithic Linux
kernel, it uses the OS/Netbased derivative kernel

known as Illumos, which is 100 per cent ABI
compatible with the Solaris kernel. In short, we can
assume that OpenIndiana is actually the
OpenSolaris operating system. It is worth mentioning
that in 2007, Sun specially hired Ian Murdock (the
Debian founder) for the development of “Project
Indiana”, to transform Solaris into OpenSolaris, and
combine the latter with a number of open source
products, such as GNOME.
Although Solaris is traditionally a server based
operating system, Open Indiana’s last public release
includes a desktop version. That is the version we’ll
be looking at, and the DVD iso can be downloaded
here. Normally, I allocate 512MB of RAM for the
VirtualBox VM. Open Indiana recommends at least
768MB of RAM, and I allocated 1024MB.
Booting from the DVD, we first see the screen
shown below. I chose the default boot option.

Alternate OS: OpenIndiana, Part 1Alternate OS: OpenIndiana, Part 1
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Next, we are asked to choose a language and
keyboard layout.

The live session boots to a Gnome 2.30.2 desktop.
There are Install OpenIndiana and GParted Partition
Editor icons on the desktop. The screenshot is a bit
hard to see, as the VirtualBox VM opened to the full
size of my host desktop, 1280x1024, and the size of
the screenshot has been reduced. Double click the

Install OpenIndiana icon, and partitioning the drive
will be part of the setup (below left).
The Welcome screen is the first one in the
installation process. Click Next to continue.

I began with a blank 20GB drive, and the two
options shown in the Disk screen are Use the whole
disk or Partition the disk. Partition the disk was
highlighted by default, and I chose that option
(center bottom).

The next step is to choose our timezone. The setup
screen shows Region, Location and Time Zone
options. I chose Americas, United States and
Central.

In the Local screen, we are asked to choose a
default Language and Territory (next page, top).

In the Users setup screen, we are asked for a root
password, a user’s name and login name, the user’s
password and a computer name (next page,
bottom).

Alternate OS: OpenIndiana, Part 1
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Displayed in the Installation screen are all the

previous choices made. At this point, we can click
Back to correct or change any chosen options, or
click Install to begin the installation.

Installing copies quite a few files from the DVD to
the hard drive (bottom, center).
After the file copies have completed, we are given
the option to Quit the installation procedure or
Reboot into our newly installed operating system.
I clicked Reboot.

I wasn’t sure if the DVD would automatically eject
and detach from the VM or not. It didn’t. I ended up
booting from the DVD again. Therefore, I chose to
boot from hard disk and the newly installed Open
Indiana OS (next page, top).

As soon as I did, I got a new GRUB boot screen
launched from the hard drive, with only one boot
option listed (next page, bottom).

Alternate OS: OpenIndiana, Part 1
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The Open Indiana boot splash is shown during
bootup, with a progress bar shown, and the

“Powered by illumos” brand and logo prominently
displayed.

The GDM login screen is displayed, asking for a
username, then the user’s password.

The Gnome desktop in the hard drive installed
edition no longer shows the installation and GParted
icons on the desktop.

I first set about changing the monitor’s display size
from its 1280x1024 size to a
more manageable one,
without having to change
xorg.conf. Actually, there
was no /etc/X11/xorg.conf
file (at right and next page,
top).
I ended up changing the
display size to 1152x864
(not shown).
Next, I updated the OS from
System > Administration >
Update Manager (next page,
bottom).

Alternate OS: OpenIndiana, Part 1
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I then rebooted. The login screen size was
1280x1024. After the desktop started, the screen

size became 1152x864. Not quite satisfied with this,
I opted to install the VirtualBox guest additions. After
installing them and rebooting again, I discovered a
minimal xorg.conf file had been written. But, now I
was confined to 640x480, 800x600 and 1024x768
screen sizes. I made some changes to the xorg.conf
file that have always worked with NetBSD, FreeBSD
and OpenBSD installations. After making the
changes and rebooting, I was unable to log in. The
progress bar on the splash screen just kept running.

OpenIndiana, being a UNIX variant, has no run
levels. It isn’t possible to log in as user root or boot
into runlevel 1 or 3. I ended up reinstalling the OS
and VirtualBox guest additions. The default screen
size is now 1024x768. After making a few tweaks, I
ended up with the desktop shown below.
The package manager interface is almost identical
to Synaptic. There aren’t many applications yet, and
only Gnome as a desktop environment. The Firefox
version available from the repository is 3.6.12.

However, the solid
Open Solarislike core
is there in the operating
system. In the next
part, we’ll look at the
features of the Z
filesystem, DTrace and
Time Slider.

Alternate OS: OpenIndiana, Part 1
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Screenshot ShowcaseScreenshot Showcase

Posted by Leiche, January 08, 2012, running LXDE.

1. All the contents of The PCLinuxOS Magazine are only for general
information and/or use. Such contents do not constitute advice
and should not be relied upon in making (or refraining from
making) any decision. Any specific advice or replies to queries in
any part of the magazine is/are the person opinion of such
experts/consultants/persons and are not subscribed to by The
PCLinuxOS Magazine.

2. The information in The PCLinuxOS Magazine is provided on an
"AS IS" basis, and all warranties, expressed or implied of any
kind, regarding any matter pertaining to any information, advice
or replies are disclaimed and excluded.

3. The PCLinuxOS Magazine and its associates shall not be liable,
at any time, for damages (including, but not limited to, without
limitation, damages of any kind) arising in contract, rot or
otherwise, from the use of or inability to use the magazine, or any
of its contents, or from any action taken (or refrained from being
taken) as a result of using the magazine or any such contents or
for any failure of performance, error, omission, interruption,
deletion, defect, delay in operation or transmission, computer
virus, communications line failure, theft or destruction or
unauthorized access to, alteration of, or use of information
contained on the magazine.

4. No representations, warranties or guarantees whatsoever are
made as to the accuracy, adequacy, reliability, completeness,
suitability, or applicability of the information to a particular
situation.

5. Certain links on the magazine lead to resources located on
servers maintained by third parties over whom The PCLinuxOS
Magazine has no control or connection, business or otherwise.
These sites are external to The PCLinuxOS Magazine and by
visiting these, you are doing so of your own accord and assume
all responsibility and liability for such action.

Material Submitted by Users
A majority of sections in the magazine contain materials submitted by
users. The PCLinuxOS Magazine accepts no responsibility for the
content, accuracy, conformity to applicable laws of such material.
Entire Agreement
These terms constitute the entire agreement between the parties with
respect to the subject matter hereof and supersedes and replaces all
prior or contemporaneous understandings or agreements, written or
oral, regarding such subject matter.

Disclaimer
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It's easier than E=mc2

It's elemental
It's light years ahead

It's a wise choice
It's Radically Simple

It's ...

A magazine just isn't a magazine
without articles to fill the pages.

If you have article ideas, or if you
would like to contribute articles to the

PCLinuxOS Magazine,
send an email to:

pclinuxos.mag@gmail.com
We are interested in general articles
about Linux, and (of course), articles

specific to PCLinuxOS.

http://www.pclinuxos.com
mailto:pclinuxos.mag@gmail.com
http://www.enkiconsulting.net/
http://pclinuxos.com/?page_id=7
http://www.oneclicklinux.com
http://www.distrowatch.com
http://www.tuxmachines.org
http://cozmodesigns.co.uk/PCLKids/index.php
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Top Left: Posted by Archie, January 18, 2012, running KDE4. Top Right: Posted by LKJ, January 6, 2012, running Xfce.
Bottom Left: Posted by RobNJ, January 11, 2012, running e17. Bottom Right: Posted by ferry_th, January 2, 2012, running Openbox.

More Screenshot ShowcaseMore Screenshot Showcase






